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SUBJECT: Computer Aided Modeling & Manufacturing 

SUBJECT CODE: 2037674(037) 

 

UNIT 2.0 COMPUTER AIDED SOLID MODELING AND ASSEMBLY 

2.1 Working in 3D environment - 

2.2 Creating 3D Solid Models of simple and complex machine parts using Extrude, Revolve, 

Sweep, variable section sweep, Draft, loft, Blend or similar 3D commands. 

2.3 Part Editing tool: Trim, Extend, Erase, Mirror, Chamfer, Round, Copy, Move, Draft, 

Boolean operations, patterns, etc. 

2.4 Parametric and non-parametric modeling concept, differences and illustration. 

2.5 Preparation of assemblies using assembly commands. Introduction to Top down and 

Bottom-up approach of assembly 

2.6 Exploded view: Explode the assembly. 
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ASSIGNMENT:2 

1. Define solid modelling. 

सॉलिड मॉडलििंग को परिभालित कीलिए। 

2. Explain the top down and bottom down approach of assembly. 

असेंबिी की टॉप डाउन एविं बॉटम डाउन एप्रोच को समझाइए। 

3. Explain the following 3D editing Commands and its function: 

लनम्नलिखित 3D एलडलटिंग डर ाइिंग कमाण्ड की व्याख्या कीलिए एविं कार्य समझाइए: 

(i) Mirror    (i) लमिि 

(ii) Extend   (ii) एक्सटेंड 

(iii) Move   (iii) मूव 

(iv) Chamfer   (iv) चािंफेि 

(v) Trim   (v) लटर म 

(vi) Round   (vi) िाउिंड 

(vii) Erase   (vii) इिेस 

 

4. Differentiate between Parametric and Non parametric modeling approaches with example.  

उदाहिण सलहत पैिामीलटरक औि गैि-पैिामीलटरक मॉडलििंग एप्रोच के बीच अिंति बताइए। 

5. Explain the following drawing 3D solid commands: 

लनम्न डर ाइिंग 3D सॉलिड कमािंड को समझाइरे्: 

(i) एकू्स्टड   (i) Extrude 

(ii) रिवॉल्व   (ii) Revolve 

(iii) स्वीप   (iii) Sweep 

(iv) िॉफ्ट   (iv) Loft 

(v) बे्लन्ड   (v) Blend 

(vi) डर ॉफ्ट   (vi) Draft 
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SOLID MODELING: 

Solid modeling is a computer-aided design (CAD) technique used to create 3D models of 

objects. Unlike other 3D modeling methods, solid modeling defines the object's entire volume, 

not just its surface. This allows for more accurate and realistic representations of objects, as 

well as more detailed analysis and simulation. 

Solid modeling is a powerful tool that can be used to create complex and realistic 3D models. 

It is an essential technology for many industries and is becoming increasingly important as 3D 

printing and other advanced manufacturing technologies become more widespread. 

 

Solid modeling in CAD 

Solid modeling is used in a variety of industries, including: 

• Manufacturing: To design and produce products 

• Engineering: To analyze and simulate the performance of products 

• Architecture: To design buildings and other structures 

• Animation: To create realistic 3D characters and environments 

Solid modeling software uses a variety of techniques to create 3D models, including: 

• Constructive solid geometry (CSG): Combining primitive shapes (such as cubes, 

cylinders, and spheres) using Boolean operations (such as union, intersection, and 

subtraction). 

• Boundary representation (B-rep): Defining the object's surface using a collection of 

faces, edges, and vertices. 

• Sweep representation: Creating a 3D object by sweeping a 2D profile along a path. 
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ठोस प्रतिरूपण (Solid Modeling):  

ठोस प्रलतरूपण (Solid Modeling) एक किं पू्यटि-सहार्ता प्राप्त लडिाइन (CAD) तकनीक है लिसका 

उपर्ोग वसु्तओिं के 3D मॉडि बनाने के लिए लकर्ा िाता है। अन्य 3D मॉडलििंग लवलिर्ोिं के लवपिीत, ठोस 

प्रलतरूपण केवि वसु्त की सतह ही नही िं, बखि उसके पूिे आर्तन को परिभालित किता है। र्ह वसु्तओिं 

के अलिक सटीक औि र्थाथयवादी प्रलतलनलित्व के साथ-साथ अलिक लवसृ्तत लवशे्लिण औि लसमुिेशन की 

अनुमलत देता है। 

ठोस प्रलतरूपण एक शखिशािी उपकिण है लिसका उपर्ोग िलटि औि र्थाथयवादी 3D मॉडि बनाने 

के लिए लकर्ा िा सकता है। र्ह कई उद्योगोिं के लिए एक आवश्यक तकनीक है औि 3D लप्रिंलटिंग औि 

अन्य उन्नत लवलनमायण प्रौद्योलगलकर्ोिं के अलिक व्यापक होते िाने के साथ र्ह तेिी से महत्वपूणय होता िा 

िहा है। 

 

Solid modeling in CAD 

ठोस प्रतिरूपण का उपयोग तितिन्न उद्योगो ों में तकया जािा है, तजनमें शातमल हैं: 

• तितनमााण: उत्पादोिं को लडिाइन औि उत्पालदत किने के लिए 

• इोंजीतनयर ोंग: उत्पादोिं के प्रदशयन का लवशे्लिण औि अनुकिण किने के लिए 

• िासु्तकला: इमाितोिं औि अन्य सिंिचनाओिं को लडिाइन किने के लिए 

• एतनमेशन: र्थाथयवादी 3D चरित्ोिं औि वाताविण बनाने के लिए 

ठोस प्रतिरूपण सॉफ्टिेय  3D मॉडल बनाने के तलए तितिन्न िकनीको ों का उपयोग क िा है, 

तजनमें शातमल हैं: 

•  चनात्मक ठोस ज्यातमति (CSG): बूलिर्न ऑपिेशन (िैसे लक सिंघ, प्रलतचे्छदन औि घटाव) 

का उपर्ोग किके आलदम आकृलतर्ोिं (िैसे लक कू्यब्स, लसिेंडि औि गोिे) को लमिाकि। 
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• सीमा प्रतितनतित्व (B-rep): चेहिोिं, लकनािोिं औि कोने के सिंग्रह का उपर्ोग किके वसु्त की 

सतह को परिभालित किना। 

• स्वीप प्रतितनतित्व: लकसी पथ के साथ 2D प्रोफाइि को स्वीप किके 3D ऑबे्जक्ट बनाना। 

 

EXPLAIN THE TOP DOWN AND BOTTOM DOWN APPROACH OF ASSEMBLY: 

Top-Down Approach 

• Focus: Starts with the overall assembly or system and breaks it down into smaller, more 

manageable components. 

• Process:  

1. Define the overall goals and requirements of the assembly. 

2. Divide the assembly into major subsystems. 

3. Further break down each subsystem into smaller components. 

4. Design and develop each component individually. 

5. Integrate the components to form the final assembly. 
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• Advantages:  

o Ensures that all components work together towards the overall goal. 

o Provides a clear and structured approach to the design process. 

o Facilitates early identification and resolution of potential issues. 

• Disadvantages:  

o Can be time-consuming and may require significant upfront planning. 

o Changes to the overall design can have ripple effects on all components. 

Bottom-Up Approach 

• Focus: Starts with individual components and gradually builds up to the complete 

assembly. 

• Process:  

1. Design and develop individual components independently. 

2. Test and verify the functionality of each component. 

3. Integrate the components into larger subsystems. 

4. Test and verify the functionality of the subsystems. 

5. Integrate the subsystems to form the final assembly. 

• Advantages:  

o Allows for early testing and validation of individual components. 

o Can be more flexible and adaptable to changes. 

o Can leverage existing components or technologies. 

• Disadvantages:  

o May lead to integration issues if components are not designed to work together. 

o Can be difficult to ensure that the final assembly meets the overall requirements. 

Which Approach to Use? 

The choice between top-down and bottom-up approaches depends on various factors, 

including: 

• Complexity of the assembly: For complex assemblies, a top-down approach may be 

more suitable to ensure that all components work together. 

• Availability of existing components: If many components are already available, a 

bottom-up approach may be more efficient. 

• Project timeline and budget: A top-down approach may be more time-consuming and 

expensive upfront, but it can reduce the risk of costly integration issues later on. 
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• Team expertise and experience: A top-down approach may require more experienced 

engineers and project managers. 

In many cases, a hybrid approach that combines elements of both top-down and bottom-up can 

be the most effective. This allows for early validation of individual components while 

maintaining a focus on the overall system requirements. 

 

शीर्ा-से-नीचे (Top-Down) दृतिकोण: 

• फोकस: समग्र असेंबिी र्ा लसस्टम से शुरू होता है औि इसे छोटे, अलिक प्रबिंिनीर् घटकोिं में 

लवभालित किता है। 

• प्रतिया:  

1. असेंबिी के समग्र िक्ष्ोिं औि आवश्यकताओिं को परिभालित किें। 

2. असेंबिी को प्रमुि उपप्रणालिर्ोिं में लवभालित किें। 

3. प्रते्यक उपप्रणािी को छोटे घटकोिं में औि तोडें। 

4. प्रते्यक घटक को व्यखिगत रूप से लडजाइन औि लवकलसत किें। 

5. अिंलतम असेंबिी बनाने के लिए घटकोिं को एकीकृत किें। 
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• लाि:  

o र्ह सुलनलित किता है लक सभी घटक समग्र िक्ष् की लदशा में लमिकि काम किते हैं। 

o लडिाइन प्रलिर्ा के लिए एक स्पष्ट औि सिंिलचत दृलष्टकोण प्रदान किता है। 

o सिंभालवत मुद्ोिं की शीघ्र पहचान औि समािान की सुलविा प्रदान किता है। 

• नुकसान:  

o समर् िेने वािा हो सकता है औि इसके लिए महत्वपूणय अलग्रम र्ोिना की आवश्यकता 

हो सकती है। 

o समग्र लडिाइन में परिवतयन सभी घटकोिं पि प्रभाव डाि सकते हैं। 

नीचे-से-ऊप  (Bottom-Up) दृतिकोण: 

• फोकस: व्यखिगत घटकोिं से शुरू होता है औि िीिे-िीिे पूिी असेंबिी तक बनता है। 

• प्रतिया:  

1. व्यखिगत घटकोिं को स्वतिंत् रूप से लडजाइन औि लवकलसत किें। 

2. प्रते्यक घटक की कार्यक्षमता का पिीक्षण औि सत्यापन किें। 

3. घटकोिं को बडी उपप्रणालिर्ोिं में एकीकृत किें। 

4. उपप्रणालिर्ोिं की कार्यक्षमता का पिीक्षण औि सत्यापन किें। 

5. अिंलतम असेंबिी बनाने के लिए उपप्रणालिर्ोिं को एकीकृत किें। 

• लाि:  

o व्यखिगत घटकोिं के शुरुआती पिीक्षण औि सत्यापन की अनुमलत देता है। 

o परिवतयनोिं के लिए अलिक िचीिा औि अनुकूिनीर् हो सकता है। 

o मौिूदा घटकोिं र्ा तकनीकोिं का िाभ उठा सकते हैं। 

• नुकसान:  

o र्लद घटकोिं को एक साथ काम किने के लिए लडजाइन नही िं लकर्ा गर्ा है तो एकीकिण 

समस्याएिं  हो सकती हैं। 

o र्ह सुलनलित किना मुखिि हो सकता है लक अिंलतम असेंबिी समग्र आवश्यकताओिं को 

पूिा किती है। 

तकस दृतिकोण का उपयोग क ना है? 

शीिय-से-नीचे औि नीचे-से-ऊपि दृलष्टकोणोिं के बीच का चुनाव लवलभन्न कािकोिं पि लनभयि किता है, लिनमें 

शालमि हैं: 
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• असेंबली की जतिलिा: िलटि असेंबलिर्ोिं के लिए, र्ह सुलनलित किने के लिए लक सभी घटक 

एक साथ काम किते हैं, शीिय-से-नीचे दृलष्टकोण अलिक उपरु्ि हो सकता है। 

• मौजूदा घिकोों की उपलब्धिा: र्लद कई घटक पहिे से ही उपिब्ध हैं, तो नीचे-से-ऊपि 

दृलष्टकोण अलिक कुशि हो सकता है। 

• प्रोजेक्ट समय ेखा औ  बजि: शीिय-से-नीचे दृलष्टकोण अलिक समर् िेने वािा औि महिंगा हो 

सकता है, िेलकन र्ह बाद में महिंगी एकीकिण समस्याओिं के िोखिम को कम कि सकता है। 

• िीम तिशेर्ज्ञिा औ  अनुिि: शीिय-से-नीचे दृलष्टकोण के लिए अलिक अनुभवी इिंिीलनर्िोिं औि 

परिर्ोिना प्रबिंिकोिं की आवश्यकता हो सकती है। 

कई मामिोिं में, शीिय-से-नीचे औि नीचे-से-ऊपि दोनोिं के तत्वोिं को लमिाने वािा एक सिंकि दृलष्टकोण 

सबसे प्रभावी हो सकता है। र्ह व्यखिगत घटकोिं के प्राििं लभक सत्यापन की अनुमलत देता है िबलक समग्र 

लसस्टम आवश्यकताओिं पि ध्यान कें लित ििता है। 
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PARAMETRIC VS. NON-PARAMETRIC MODELING 

Parametric and non-parametric modeling are two distinct approaches in machine learning and 

statistics, each with its own strengths and weaknesses. Here's a breakdown of their key 

differences: 

Parametric Modeling: 

Definition: Assumes a specific mathematical function (e.g., linear, polynomial) to represent 

the data. 

Key Characteristics: 

● Assumes a specific functional form: Parametric models assume that the data follows a 

particular distribution or function, such as a linear relationship or a normal distribution. 

● Fixed number of parameters: These models have a fixed number of parameters that 

need to be estimated from the data. 

● Simpler and faster: Generally, parametric models are easier to train and make 

predictions with, as they involve fewer computations. 

● Less flexible: The assumption of a specific functional form can limit the model's ability 

to capture complex relationships in the data, especially if the true underlying relationship 

is different from the assumed one. 
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Examples: 

● Linear Regression: Models the relationship between a dependent variable and one or 

more independent variables as a linear equation. 

● Logistic Regression: Used for binary classification problems, modeling the probability 

of an instance belonging to a particular class. 

● Naive Bayes: A probabilistic classifier based on Bayes' theorem with strong 

independence assumptions between features. 

Non-Parametric Modeling 

Definition: Does not assume a specific functional form for the data. 

Key Characteristics: 

● No assumptions about the functional form: Non-parametric models do not assume any 

specific distribution or function for the data. 

● Flexible number of parameters: The number of parameters in these models can grow 

with the size of the training data, allowing them to adapt to complex relationships. 

● More complex and slower: Non-parametric models can be computationally more 

expensive to train and make predictions with, especially for large datasets. 

● More flexible: The lack of assumptions about the functional form makes non-parametric 

models more capable of capturing complex and non-linear relationships in the data. 

Examples: 

● K-Nearest Neighbors (KNN): Classifies new data points based on the majority class 

among their k nearest neighbors in the training data. 

● Support Vector Machines (SVM): Finds an optimal hyperplane to separate data points 

into different classes. 

● Decision Trees: Create a tree-like model of decisions and their possible consequences, 

used for both classification and regression. 

Choosing between Parametric and Non-Parametric Models: 

The choice between parametric and non-parametric models depends on several factors: 

● Understanding of the data: If you have a good understanding of the underlying data 

distribution and the relationship between variables, a parametric model might be a good 

choice. 

● Data size: For large datasets, parametric models can be more efficient to train and use. 

● Model complexity: If the relationship between variables is complex and non-linear, a 

non-parametric model might be more suitable. 
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● Computational resources: Non-parametric models can be computationally expensive, 

so consider the available resources before choosing one. 

Here's a table summarizing the key differences 

   

Feature Parametric Non-Parametric 

Assumed function Specific function (e.g., linear) No specific function 

Number of parameters Fixed Grows with data size 

Data assumptions Strong Fewer 

Flexibility Less flexible More flexible 

Training time Generally faster Often slower 

Data requirements Less data More data 

Example Linear Regression K-Nearest Neighbors 

 

पैरामीट्रिक बनाम नॉन-पैरामीट्रिक मॉडट् िंग 

मशीन लर्निंग और स ांख्यिकी में पैर मीर्रि क और नॉन-पैर मीर्रि क मॉडर्लांग दो अलग-अलग दृर्िकोण हैं, 

र्िनमें से प्रते्यक की अपनी त कत और कमिोररय ां हैं। यह ाँ उनके मुि अांतरोां क  र्ििरण र्दय  गय  है: 

पैरामीट्रिक मॉडट् िंग: 

पर िार्ा: डेटा का प्रलतलनलित्व किने के लिए एक लवलशष्ट गलणतीर् फिन (िैसे, िैखिक, बहुपद) मानता 

है। 

मुख्य तिशेर्िाएों : 

● एक ट्िट्िष्ट कार्ाात्मक रूप मानता है: पैर मीर्रि क मॉडल म नते हैं र्क डेर  एक र्िशेष र्ितरण 

य  फां क्शन क  अनुसरण करत  है, िैसे र्क एक रैख्यिक सांबांध य  एक स म न्य र्ितरण। 

● पैरामीरर की ट्नट्ित सिंख्या: इन मॉडलोां में पैर मीरर की एक र्नर्ित सांि  होती है र्िन्हें डेर  

से अनुम र्नत करने की आिश्यकत  होती है। 

● सर  और तेज: आम तौर पर, पैर मीर्रि क मॉडल को प्रर्शर्ित करन  और भर्िष्यि र्णय ां करन  

आस न होत  है, क्ोांर्क इसमें कम गणन  श र्मल होती है। 

● कम  ची ा: एक र्िर्शि क य ात्मक रूप की ध रण  मॉडल की डेर  में िर्रल सांबांधोां को पकड़ने 

की िमत  को सीर्मत कर सकती है, ि सकर यर्द सही अांतर्नार्हत सांबांध म न  गय  एक से अलग 

है। 
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उदाहरण: 

● रैखिक प्रट्तगमन: एक आर्ित चर और एक य  अर्धक स्वतांत्र चर के बीच के सांबांध को एक 

रैख्यिक समीकरण के रूप में मॉडल करत  है। 

●  ॉट्जखिक ररगे्रिन: ब इनरी िगीकरण समस्य ओां के र्लए उपयोग र्कय  ि त  है, र्कसी र्िशेष 

िगा से सांबांर्धत होने की सांभ िन  क  मॉडर्लांग। 

● नाइि बेज: बेि प्रमेय पर आध ररत एक प्र र्यकत  िगीक रक र्िसमें सुर्िध ओां के बीच मिबूत 

स्वतांत्रत  ध रण एां  होती हैं। 

नॉन-पैरामीट्रिक मॉडट् िंग: 

पर िार्ा: डेटा के लिए लकसी लवलशष्ट कार्ायत्मक रूप को मानता नही िं है। 

मुख्य तिशेर्िाएों : 

● कार्ाात्मक रूप के बारे में कोई धारणा नही िं: नॉन-पैर मीर्रि क मॉडल डेर  के र्लए र्कसी र्िर्शि 

र्ितरण य  फां क्शन को नही ां म नते हैं। 

● पैरामीरर की  ची ी सिंख्या: इन मॉडलोां में पैर मीरर की सांि  प्रर्शिण डेर  के आक र के 

स थ बढ़ सकती है, र्िससे उन्हें िर्रल सांबांधोां के अनुकूल होने की अनुमर्त र्मलती है। 

● अट्धक जट्र  और धीमा: नॉन-पैर मीर्रि क मॉडल को प्रर्शर्ित करन  और भर्िष्यि र्णय ां 

करन  अर्धक महांग  हो सकत  है, ि सकर बडे़ डेर सेर के र्लए। 

● अट्धक  ची ा: क य ात्मक रूप के ब रे में ध रण ओां की कमी नॉन-पैर मीर्रि क मॉडल को डेर  
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में िर्रल और गैर-रैख्यिक सांबांधोां को पकड़ने में सिम बन ती है। 

उदाहरण: 

● के-ट्नकरतम पडोसी (केएनएन): प्रर्शिण डेर  में अपने के र्नकरतम पड़ोर्सयोां के बीच बहुमत 

िगा के आध र पर नए डेर  र्बांदुओां को िगीकृत करत  है। 

● सपोरा िेक्टर मिीन (एसिीएम): डेर  र्बांदुओां को अलग-अलग िगों में अलग करने के र्लए एक 

इितम ह इपरपे्लन ढूांढत  है। 

● ट्नणार् िृक्ष: र्नणायोां और उनके सांभ र्ित पररण मोां क  एक िृि िैस  मॉडल बन त  है, र्िसक  

उपयोग िगीकरण और प्रर्तगमन दोनोां के र्लए र्कय  ि त  है। 

पैरामीट्रिक और नॉन-पैरामीट्रिक मॉड  के बीच चर्न करना 

पैर मीर्रि क और नॉन-पैर मीर्रि क मॉडल के बीच क  चुन ि कई क रकोां पर र्नभार करत  है: 

● डेरा की समझ: यर्द आपको अांतर्नार्हत डेर  र्ितरण और चर के बीच सांबांध की अच्छी समझ है, 

तो एक पैर मीर्रि क मॉडल एक अच्छ  र्िकल्प हो सकत  है। 

● डेरा का आकार: बडे़ डेर सेर के र्लए, पैर मीर्रि क मॉडल को प्रर्शर्ित करन  और उपयोग 

करन  अर्धक कुशल हो सकत  है। 

● मॉड  की जट्र ता: यर्द चर के बीच क  सांबांध िर्रल और गैर-रैख्यिक है, तो एक गैर-पैर मीर्रि क 

मॉडल अर्धक उपयुक्त हो सकत  है। 

● किं पू्यरेिन  सिंसाधन: नॉन-पैर मीर्रि क मॉडल कम्प्यूरेशनल रूप से महांगे हो सकते हैं, इसर्लए 

एक क  चयन करने से पहले उपलब्ध सांस धनोां पर र्िच र करें। 

यहाां एक तालिका है जो प्रमुख अांतरों को साराांलित करती है 

   

वििेषता पैरामीट्रिक नॉन-पैरामीट्रिक 

ग्रहण ककया गया कायय विशिष्ट फ़ं क्िन (जैसे, रैखिक) कोई विशिष्ट फ़ं क्िन नह ़ं 
मापदांडों की सांख्या ननश्चित डेटा आकार के साथ बढ़ता है 

डेटा मान्यताएां मजबूत कम 

िचीिापन कम लिीला अधिक लिीला 
प्रलिक्षण समय आमतौर पर तेज अक्सर िीमा 
डेटा आिश्यकताएँ कम डेटा अधिक डेटा 
उदाहरण रैखिक प्रनतगमन K-ननकटतम पडोसी 
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COMMANDS TO CREATE 3D SOLID MODEL 

Commonly used Commands to generate 3D Solid Model are discussed below. 

1. Extrude   5. Loft 

2. Revolve   6. Blend 

3. Sweep   7. Composite 

4. Draft 

3D Extrude Command in AutoCAD: 

The 3D Extrude command in AutoCAD is a powerful tool used to create 3D objects by 

extending a 2D shape or profile along a specified path or direction. This process is essential for 

building complex 3D models, from simple boxes to intricate architectural structures. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "EXTRUDE" in the command line and press Enter. 

○ Alternatively, click on the "Extrude" icon in the 3D Modeling workspace. 

2. Select the Object: 

○ Select the 2D shape or profile you want to extrude. This could be a line, circle, 

polygon, or any closed shape. 

3. Specify Extrusion Parameters: 

○ Height/Direction: 

■ Specify Height: Enter a numerical value for the desired height of the 

extrusion. A positive value extrudes the object upwards, while a negative 

value extrudes it downwards. 

■ Specify Direction: Click two points in the 3D space to define the direction 

and length of the extrusion. 

4. Additional Options (Optional): 

○ Path: Select a path object (e.g., a spline or polyline) to extrude the shape along a 

curved trajectory. 

○ Taper Angle: Specify an angle to create a tapered extrusion, resulting in a conical 

or pyramidal shape. 

○ Twist Angle: Rotate the object around the extrusion axis as it is extruded. 

5. Complete the Command: 
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○ Press Enter to complete the extrusion process. 

 

 

Example: Creating a Cylinder 

1. Draw a Circle: Use the Circle tool to draw a circle in the XY plane. 

2. Extrude the Circle: 

○ Type "EXTRUDE" and press Enter. 

○ Select the circle. 

○ Enter a positive height value to extrude the circle upwards, creating a cylinder. 

AutoCAD में 3D एक्सटू्रड कमािंड: 

AutoCAD में 3D एक्सटू्रड कम ांड एक शख्यक्तश ली उपकरण है र्िसक  उपयोग र्कसी 2D आकृर्त य  

प्रोफ इल को र्कसी र्नर्दाि पथ य  र्दश  के स थ र्िस्त ररत करके 3D ऑबे्जक्ट बन ने के र्लए र्कय  ि त  

है। यह प्रर्िय  स ध रण बॉक्स से लेकर िर्रल ि सु्तर्शल्प सांरचन ओां तक, िर्रल 3D मॉडल बन ने के 

र्लए आिश्यक है। 

चरण-दर-चरण प्रट्िर्ा: 
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1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "EXTRUDE" र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में "Extrude" आइकन पर ख्यिक करें। 

2. ऑबे्जक्ट का चर्न करें : 

○ उस 2D आकृर्त य  प्रोफ इल क  चयन करें  र्िसे आप एक्सटू्रड करन  च हते हैं। यह एक 

रेि , िृत्त, बहुभुि य  कोई भी बांद आकृर्त हो सकती है। 

3. एक्सटू्रज़न पैरामीरर ट्नट्दाष्ट करें : 

○ ऊिं चाई/ट्दिा: 

■ ऊिं चाई ट्नट्दाष्ट करें : एक्सटू्रज़न की ि ांर्ित ऊां च ई के र्लए एक सांि त्मक म न दिा 

करें। एक सक र त्मक म न ऑबे्जक्ट को ऊपर की ओर एक्सटू्रड करत  है, िबर्क 

एक नक र त्मक म न इसे नीचे की ओर एक्सटू्रड करत  है। 

■ ट्दिा ट्नट्दाष्ट करें : एक्सटू्रज़न की र्दश  और लांब ई को पररभ र्षत करने के र्लए 

3D अांतररि में दो र्बांदुओां पर ख्यिक करें। 

4. अट्तररक्त ट्िकल्प (िैकखल्पक): 

○ पथ: िि पथ के स थ आकृर्त को एक्सटू्रड करने के र्लए एक पथ ऑबे्जक्ट (िैसे, स्पल इन 

य  पॉलील इन) क  चयन करें। 

○ रेपर कोण: एक शांक्व क र य  र्पर र्मडनुम  आक र बन ने के र्लए एक रेपडा एक्सटू्रज़न 

बन ने के र्लए एक कोण र्नर्दाि करें। 

○ ट्िि कोण: एक्सटू्रज़न के दौर न ऑबे्जक्ट को एक्सटू्रज़न अि के च रोां ओर घुम एां । 

5. कमािंड पूरा करें : 

○ एक्सटू्रज़न प्रर्िय  को पूर  करने के र्लए Enter दब एां । 
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उदाहरण: एक ट्स ेंडर बनाना 

1. एक िृत्त िी िंचें: XY समतल में एक िृत्त िी ांचने के र्लए िृत्त उपकरण क  उपयोग करें। 

2. िृत्त को एक्सटू्रड करें : 

○ "EXTRUDE" र इप करें  और Enter दब एां । 

○ िृत्त क  चयन करें। 

○ र्सलेंडर बन ने के र्लए िृत्त को ऊपर की ओर एक्सटू्रड करने के र्लए एक सक र त्मक 

ऊां च ई म न दिा करें। 

AutoCAD's 3D Revolve Command: 

The 3D Revolve command in AutoCAD is a powerful tool used to create 3D objects by rotating 

a 2D profile or shape around an axis. This technique is effective for generating symmetrical 

and rotational objects, such as cylinders, cones, spheres, and other curved or rounded shapes. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "REV" or "REVOLVE" in the command line and press Enter. 

○ Alternatively, click on the "Revolve" icon in the 3D Modeling workspace. 

2. Select the Object: 

○ Select the 2D shape or profile you want to revolve. This could be a line, circle, arc, 

or any closed shape. 

3. Specify Axis of Rotation: 

○ Select Axis: 
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■ Click two points to define the start and end points of the axis of rotation. 

■ Select an existing line or edge as the axis of rotation. 

○ Choose Predefined Axis: 

■ Select the X, Y, or Z-axis as the axis of rotation. 

4. Specify Angle of Revolution (Optional): 

○ Enter the desired angle of revolution. 

■ For a full revolution, enter 360 degrees. 

■ For partial revolutions, enter the desired angle. 

5. Complete the Command: 

○ Press Enter to complete the revolution process. 
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Example: Creating a Cylinder 

1. Draw a Circle: Use the Circle tool to draw a circle in the XY plane. 

2. Revolve the Circle: 

○ Type "REV" and press Enter. 

○ Select the circle. 

○ Select the Z-axis as the axis of rotation. 

○ Enter "360" for a full revolution. 

AutoCAD में 3D ररिॉल्व कमािंड: 

AutoCAD में 3D ररिॉल्व कम ांड एक शख्यक्तश ली उपकरण है र्िसक  उपयोग र्कसी 2D प्रोफ इल य  

आकृर्त को र्कसी अि के च रोां ओर घुम कर 3D ऑबे्जक्ट बन ने के र्लए र्कय  ि त  है। यह तकनीक 

र्सलेंडर, शांकु, गोले और अन्य घुम िद र य  गोल आकृर्तयोां िैसे समर्मत और घूणी िसु्तओां को उत्पन्न 

करने के र्लए प्रभ िी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "REV" य  "REVOLVE" र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में "Revolve" आइकन पर ख्यिक करें। 

2. ऑबे्जक्ट का चर्न करें : 

○ उस 2D आकृर्त य  प्रोफ इल क  चयन करें  र्िसे आप घुम न  च हते हैं। यह एक रेि , िृत्त, 

च प य  कोई भी बांद आकृर्त हो सकती है। 

3. घूणान की अक्ष ट्नट्दाष्ट करें : 

○ अक्ष का चर्न करें : 

■ घूणान अि के प्र रांभ और अांत र्बांदुओां को पररभ र्षत करने के र्लए दो र्बांदुओां पर 

ख्यिक करें। 

■ घूणान अि के रूप में र्कसी मौिूद  रेि  य  र्कन रे क  चयन करें। 

○ पूिाट्नधााररत अक्ष चुनें: 

■ घूणान अि के रूप में X, Y य  Z-अि क  चयन करें। 

4. घूणान का कोण ट्नट्दाष्ट करें  (िैकखल्पक): 
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○ घूणान क  ि ांर्ित कोण दिा करें। 

■ पूणा पररिमण के र्लए, 360 र्डग्री दिा करें। 

■ आांर्शक पररिमण के र्लए, ि ांर्ित कोण दिा करें। 

5. कमािंड पूरा करें : 

○ घूणान प्रर्िय  को पूर  करने के र्लए Enter दब एां । 

 

 

उदाहरण: एक ट्स ेंडर बनाना 

1. एक िृत्त िी िंचें: XY समतल में एक िृत्त िी ांचने के र्लए िृत्त उपकरण क  उपयोग करें। 

2. िृत्त को घुमाएिं : 

○ "REV" र इप करें  और Enter दब एां । 

○ िृत्त क  चयन करें। 

○ घूणान अि के रूप में Z-अि क  चयन करें। 

○ पूणा पररिमण के र्लए "360" दिा करें। 
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AutoCAD's 3D Sweep Command: 

The 3D Sweep command in AutoCAD is a versatile tool used to create 3D objects by sweeping 

a 2D profile along a defined path. This technique is effective for generating a wide range of 

shapes, from simple extrusions to complex, twisted forms. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "SWEEP" in the command line and press Enter. 

○ Alternatively, click on the "Sweep" icon in the 3D Modeling workspace. 

2. Select the Profile: 

○ Select the 2D shape or profile you want to sweep. This could be a line, circle, arc, 

or any closed shape. 

3. Specify the Path: 

○ Select the path object along which you want to sweep the profile. This could be a 

line, spline, polyline, or any other suitable path. 

4. Specify Options (Optional): 

○ Twist: Rotate the profile around the path as it is swept, creating twisted or helical 

shapes. 

○ Path Alignment: Control how the profile is aligned to the path (e.g., normal to 

the path, tangent to the path). 

○ Mode: Choose between creating a surface or a solid object. 

5. Complete the Command: 

○ Press Enter to complete the sweep process. 
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Example: Creating a Spiral Staircase 

1. Draw a Profile: Draw a rectangle to represent the width and depth of a single stair step. 

2. Create a Path: Draw a helical or spiral-shaped polyline to define the path of the 

staircase. 

3. Sweep the Profile: 

○ Type "SWEEP" and press Enter. 

○ Select the rectangle (profile). 

○ Select the helical polyline (path). 

○ (Optional) Enable the "Twist" option to rotate the steps along the path. 

AutoCAD में 3D स्वीप कमािंड: 

AutoCAD में 3D स्वीप कम ांड एक बहुमुिी उपकरण है र्िसक  उपयोग र्कसी 2D प्रोफ इल को 

पररभ र्षत पथ के स थ स्वीप करके 3D ऑबे्जक्ट बन ने के र्लए र्कय  ि त  है। यह तकनीक सरल 

एक्सटू्रज़न से लेकर िर्रल, मुड़ते हुए रूपोां तक, आकृर्तयोां की एक र्िसृ्तत िृांिल  को उत्पन्न करने के 

र्लए प्रभ िी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "SWEEP" र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में "Sweep" आइकन पर ख्यिक करें। 

2. प्रोफाइ  का चर्न करें : 

○ उस 2D आकृर्त य  प्रोफ इल क  चयन करें  र्िसे आप स्वीप करन  च हते हैं। यह एक रेि , 
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िृत्त, च प य  कोई भी बांद आकृर्त हो सकती है। 

3. पथ ट्नट्दाष्ट करें : 

○ उस पथ ऑबे्जक्ट क  चयन करें  र्िसके स थ आप प्रोफ इल को स्वीप करन  च हते हैं। यह 

एक रेि , स्पल इन, पॉलील इन य  कोई अन्य उपयुक्त पथ हो सकत  है। 

4. ट्िकल्प ट्नट्दाष्ट करें  (िैकखल्पक): 

○ ट्िि: स्वीप र्कए ि ने पर प्रोफ इल को पथ के च रोां ओर घुम एां , मुड़ते हुए य  पेचद र 

आक र बन एां । 

○ पथ सिंरेिण: र्नयांर्त्रत करें  र्क प्रोफ इल को पथ के स थ कैसे सांरेख्यित र्कय  ि त  है 

(उद हरण के र्लए, पथ के स म न्य, पथ के स्पशारेि )। 

○ मोड: सतह य  ठोस िसु्त बन ने के बीच चुनें। 

5. कमािंड पूरा करें : 

○ स्वीप प्रर्िय  को पूर  करने के र्लए Enter दब एां । 

 

 



 

25 
 

उदाहरण: एक सट्पा  सीढी बनाना 

1. एक प्रोफाइ  बनाएिं : एक सीढ़ी के एकल चरण की चौड़ ई और गहर ई क  प्रर्तर्नर्धत्व करने के 

र्लए एक आयत बन एां । 

2. एक पथ बनाएिं : सीढ़ी के पथ को पररभ र्षत करने के र्लए एक पेचद र य  सर्पाल-आक र की 

पॉलील इन बन एां । 

3. प्रोफाइ  को स्वीप करें : 

○ "SWEEP" र इप करें  और Enter दब एां । 

○ आयत (प्रोफ इल) क  चयन करें। 

○ पेचद र पॉलील इन (पथ) क  चयन करें। 

○ (िैकख्यल्पक) पथ के स थ चरणोां को घुम ने के र्लए "र्िस्ट" र्िकल्प को सिम करें। 

3D Draft Command in AutoCAD: 

The 3D Draft command in AutoCAD is a powerful tool that allows you to create 3D models 

from 2D drawings. It's particularly useful when you have existing 2D blueprints or sketches 

and want to convert them into a 3D representation. 

Step-by-Step Procedure: 

1. Prepare Your 2D Drawing: 

○ Ensure your 2D drawing is complete and accurate. 

○ Use appropriate layers and colors for better organization. 

2. Access the 3D Draft Command: 

○ Type 3ddraft in the command line and press Enter. 

○ Alternatively, you can find it in the ribbon under the "3D Modeling" tab. 

3. Select the 2D Objects: 

○ Select the 2D objects (lines, arcs, circles, etc.) that you want to convert to 3D. 

4. Specify the Draft Plane: 

○ Choose the plane on which the 2D objects will be projected. This could be the XY 

plane, YZ plane, or XZ plane. 

5. Set the Draft Direction: 

○ Define the direction in which the 3D objects will be extruded. This is typically 

perpendicular to the draft plane. 
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6. Specify the Draft Distance: 

○ Enter the desired distance for the 3D extrusion. 

7. Review and Modify: 

○ Once the 3D objects are created, you can use other 3D modeling tools to modify 

and refine them as needed. 

 

Example: Creating a Simple Box 

1. Draw a 2D Rectangle: 

○ Use the Rectangle command to draw a rectangle on the XY plane. 

2. Access 3D Draft: 

○ Type 3ddraft and press Enter. 

3. Select the Rectangle: 

○ Select the rectangle you just drew. 

4. Specify Draft Plane and Direction: 

○ Choose the XY plane as the draft plane. 

○ Set the draft direction as the Z-axis (upward). 

5. Enter Draft Distance: 

○ Enter the desired height of the box. 

6. Result: 

○ A 3D box will be created, extruded from the 2D rectangle along the Z-axis. 
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Additional Tips: 

● Use the UCS (User Coordinate System) command to define custom coordinate systems 

for more complex drafting scenarios. 

● The 3D Draft command can also be used to create 3D objects from multiple 2D objects. 

● Experiment with different draft planes and directions to achieve the desired 3D shape. 

AutoCAD में 3D डि ाफ्ट कमािंड: 

AutoCAD में 3D डि  फ्ट कम ांड एक शख्यक्तश ली उपकरण है िो आपको 2D डि  इांग्स से 3D मॉडल बन ने 

की अनुमर्त देत  है। यह र्िशेष रूप से उपयोगी होत  है िब आपके प स मौिूद  2D बू्लर्प्रांर य  से्कच 

होते हैं और आप उन्हें 3D प्रर्तर्नर्धत्व में बदलन  च हते हैं। 

चरण-दर-चरण प्रट्िर्ा: 

1. अपनी 2D डि ाइिंग तैर्ार करें : 

○ सुर्नर्ित करें  र्क आपकी 2D डि  इांग पूणा और सरीक है। 

○ बेहतर सांगठन के र्लए उपयुक्त परतोां और रांगोां क  उपयोग करें। 

2. 3D डि ाफ्ट कमािंड तक पहिंचें: 

○ कम ांड ल इन में 3ddraft र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, आप इसे ररबन में "3D मॉडर्लांग" रैब के अांतगात प  सकते हैं। 

3. 2D ऑबे्जक््टस का चर्न करें : 

○ उन 2D ऑबे्जक््टस (ल इनोां, आक्सा, सका ल आर्द) क  चयन करें  र्िन्हें आप 3D में बदलन  

च हते हैं। 

4. डि ाफ्ट पे्लन ट्नट्दाष्ट करें : 

○ उस पे्लन क  चयन करें  र्िस पर 2D ऑबे्जक््टस को प्रोिेक्ट र्कय  ि एग । यह XY पे्लन, 

YZ पे्लन य  XZ पे्लन हो सकत  है। 

5. डि ाफ्ट ट्दिा ट्नधााररत करें : 

○ उस र्दश  को पररभ र्षत करें  र्िसमें 3D ऑबे्जक््टस को ब हर र्नक ल  ि एग । यह 

आमतौर पर डि  फ्ट पे्लन के लांबित होत  है। 

6. डि ाफ्ट दूरी ट्नट्दाष्ट करें : 

○ 3D एक्सटू्रज़न के र्लए ि ांर्ित दूरी दिा करें। 

7. समीक्षा करें  और सिंिोट्धत करें : 
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○ एक ब र 3D ऑबे्जक््टस बन ि ने के ब द, आप उन्हें आिश्यकत नुस र सांशोर्धत करने 

और पररषृ्कत करने के र्लए अन्य 3D मॉडर्लांग रूल क  उपयोग कर सकते हैं। 

 

उदाहरण: एक साधारण बॉक्स बनाना 

1. एक 2D आर्त बनाएिं : 

○ XY पे्लन पर एक आयत बन ने के र्लए Rectangle कम ांड क  उपयोग करें। 

2. 3D डि ाफ्ट तक पहिंचें: 

○ 3ddraft र इप करें  और Enter दब एां । 

3. आर्त का चर्न करें : 

○ आपके द्व र  अभी बन ए गए आयत क  चयन करें। 

4. डि ाफ्ट पे्लन और ट्दिा ट्नट्दाष्ट करें : 

○ XY पे्लन को डि  फ्ट पे्लन के रूप में चुनें। 

○ डि  फ्ट र्दश  को Z-अि (ऊपर की ओर) के रूप में सेर करें। 

5. डि ाफ्ट दूरी दजा करें : 

○ बॉक्स की ि ांर्ित ऊां च ई दिा करें। 

6. पररणाम: 

○ Z-अि के स थ 2D आयत से ब हर र्नक ल  गय  एक 3D बॉक्स बन य  ि एग । 
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AutoCAD's 3D Loft Command: 

The 3D Loft command in AutoCAD is a versatile tool used to create complex 3D objects by 

smoothly blending a series of cross-sectional shapes. This technique is particularly useful for 

modeling organic shapes, such as car bodies, aircraft fuselages, and bottles. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "LOFT" in the command line and press Enter. 

○ Alternatively, click on the "Loft" icon in the 3D Modeling workspace. 

2. Select Cross Sections: 

○ Select the first cross-sectional shape. This could be any closed 2D shape, such as 

a circle, rectangle, or polygon. 

○ Select subsequent cross-sectional shapes in the desired order. The order of 

selection significantly influences the final 3D shape. 

3. Specify Options (Optional): 

○ Path: Select a path object (e.g., a spline or polyline) to guide the loft along a 

specific trajectory. 

○ Mode: Choose between creating a surface or a solid object. 

○ Preview: Enable preview mode to visualize the 3D shape as you select cross 

sections. 

4. Complete the Command: 

○ Press Enter to complete the loft process. 
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Example: Creating a Vase 

1. Draw Cross Sections: 

○ Draw a circle for the base of the vase. 

○ Draw a smaller circle for the top of the vase. 

○ Draw an intermediate elliptical shape for the widest part of the vase. 

2. Loft the Shapes: 

○ Type "LOFT" and press Enter. 

○ Select the base circle, then the elliptical shape, and finally the top circle. 

○ Press Enter to create the 3D vase. 

AutoCAD में 3D  ोफ्ट कमािंड: 

AutoCAD में 3D लोफ्ट कम ांड एक बहुमुिी उपकरण है र्िसक  उपयोग िॉस-सेक्शनल आकृर्तयोां 

की एक िृांिल  को सुच रू रूप से र्मल कर िर्रल 3D ऑबे्जक्ट बन ने के र्लए र्कय  ि त  है। यह 

तकनीक क र बॉडी, र्िम न के फू्यज़लेि और बोतलोां िैसी िैर्िक आकृर्तयोां को मॉडर्लांग के र्लए र्िशेष 

रूप से उपयोगी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "LOFT" र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में "Loft" आइकन पर ख्यिक करें। 

2. िॉस सेक्शन का चर्न करें : 

○ पहली िॉस-सेक्शनल आकृर्त क  चयन करें। यह कोई भी बांद 2D आकृर्त हो सकती है, 

िैसे र्क िृत्त, आयत य  बहुभुि। 

○ ि ांर्ित िम में ब द की िॉस-सेक्शनल आकृर्तयोां क  चयन करें। चयन क  िम अांर्तम 3D 

आक र को महत्वपूणा रूप से प्रभ र्ित करत  है। 

3. ट्िकल्प ट्नट्दाष्ट करें  (िैकखल्पक): 

○ पथ: एक र्िर्शि प्रिेपिि के स थ लोफ्ट क  म गादशान करने के र्लए एक पथ ऑबे्जक्ट 

(िैसे, स्पल इन य  पॉलील इन) क  चयन करें। 

○ मोड: सतह य  ठोस िसु्त बन ने के बीच चुनें। 

○ पूिााि ोकन: िॉस सेक्शन क  चयन करते समय 3D आक र क  पूि ािलोकन करने के 
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र्लए पूि ािलोकन मोड सिम करें। 

4. कमािंड पूरा करें : 

○ लोफ्ट प्रर्िय  को पूर  करने के र्लए Enter दब एां । 

 

 

उदाहरण: एक फू दान बनाना 

1. िॉस सेक्शन बनाएिं : 

○ फूलद न के आध र के र्लए एक िृत्त बन एां । 

○ फूलद न के शीषा के र्लए एक िोर  िृत्त बन एां । 

○ फूलद न के सबसे चौडे़ र्हसे्स के र्लए एक मध्यिती अण्ड क र आक र बन एां । 

2. आकृट्तर्ो िं को  ोफ्ट करें : 

○ "LOFT" र इप करें  और Enter दब एां । 

○ आध र िृत्त, र्फर अण्ड क र आक र और अांत में शीषा िृत्त क  चयन करें। 

○ 3D फूलद न बन ने के र्लए Enter दब एां । 

 

 

AutoCAD's 3D Blend Command: 
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The 3D Blend command in AutoCAD is a powerful tool used to create smooth, transitional 

surfaces between two or more existing surfaces. This is particularly useful for modeling organic 

shapes, complex geometries, and objects with flowing curves. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "BLENDSRF" or "SURFBLEND" in the command line and press Enter. 

○ Alternatively, click on the "Blend Surfaces" icon in the 3D Modeling workspace. 

2. Select the First Surface Edge: 

○ Select the first edge of the surface you want to blend. This could be any edge of a 

3D surface. 

3. Select the Second Surface Edge: 

○ Select the second edge of the surface you want to blend. Ensure that the selected 

edges are compatible for blending (e.g., they should have similar shapes and 

orientations). 

4. Specify Options (Optional): 

○ Continuity: Control the smoothness of the blend surface by adjusting the 

continuity level (G0, G1, G2). Higher continuity levels result in smoother 

transitions. 

○ Bulge Magnitude: Adjust the shape of the blend surface by specifying a bulge 

magnitude. This can be used to create more complex and organic shapes. 

5. Complete the Command: 

○ Press Enter to complete the blend process. 
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Example: Blending Two Cylinders 

1. Create Two Cylinders: Create two cylinders of different diameters and heights. 

2. Blend the Cylinders: 

○ Type "BLENDSRF" and press Enter. 

○ Select the top edge of the smaller cylinder. 

○ Select the bottom edge of the larger cylinder. 

AutoCAD में 3D ब्लेंड कमािंड: 

AutoCAD में 3D ब्लेंड कम ांड दो य  अर्धक मौिूद  सतहोां के बीच र्चकनी, सांिमणक लीन सतह बन ने 

के र्लए उपयोग र्कय  ि ने ि ल  एक शख्यक्तश ली उपकरण है। यह िैर्िक आकृर्तयोां, िर्रल ज्य र्मर्त 

और बहने ि ले ििोां ि ली िसु्तओां को मॉडर्लांग के र्लए र्िशेष रूप से उपयोगी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "BLENDSRF" य  "SURFBLEND" र इप करें  और Enter दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में "Blend Surfaces" आइकन पर ख्यिक करें। 

2. पह ी सतह ट्कनारा चुनें: 

○ उस सतह के पहले र्कन रे क  चयन करें  र्िसे आप र्मल न  च हते हैं। यह र्कसी भी 3D 

सतह क  कोई भी र्कन र  हो सकत  है। 

3. दूसरी सतह ट्कनारा चुनें: 

○ उस सतह के दूसरे र्कन रे क  चयन करें  र्िसे आप र्मल न  च हते हैं। सुर्नर्ित करें  र्क 

चयर्नत र्कन रे र्मिण के र्लए सांगत हैं (उद हरण के र्लए, उनके आक र और अर्भर्िन्य स 
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सम न होने च र्हए)। 

4. ट्िकल्प ट्नट्दाष्ट करें  (िैकखल्पक): 

○ ट्नरिंतरता: र्नरांतरत  स्तर (G0, G1, G2) को सम योर्ित करके र्मिण सतह की र्चकन ई 

को र्नयांर्त्रत करें। उच्च र्नरांतरत  स्तर से अर्धक र्चकने सांिमण होते हैं। 

○ उभार पररमाण: उभ र पररम ण र्नर्दाि करके र्मिण सतह के आक र को सम योर्ित 

करें। इसक  उपयोग अर्धक िर्रल और िैर्िक आक र बन ने के र्लए र्कय  ि  सकत  

है। 

5. कमािंड पूरा करें : 

○ र्मिण प्रर्िय  को पूर  करने के र्लए Enter दब एां । 
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उदाहरण: दो ट्स ेंडरो िं को ट्म ाना 

1. दो ट्स ेंडर बनाएिं : र्िर्भन्न व्य स और ऊां च इयोां के दो र्सलेंडर बन एां । 

2. ट्स ेंडरो िं को ट्म ाएिं : 

○ "BLENDSRF" र इप करें  और Enter दब एां । 

○ िोरे र्सलेंडर के शीषा र्कन रे क  चयन करें। 

○ बडे़ र्सलेंडर के र्नचले र्कन रे क  चयन करें। 

AutoCAD's 3D Composite Command: 

The 3D Composite command in AutoCAD is a versatile tool that allows you to combine, 

subtract, or intersect multiple 3D solids, surfaces, or regions to create complex 3D objects. This 

is essential for creating intricate shapes and models by manipulating the volumes of existing 

3D elements. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Type "UNION," "SUBTRACT," or "INTERSECT" in the command line and press 

Enter. 

○ Alternatively, click on the corresponding icon in the 3D Modeling workspace. 

2. Select Objects: 

○ Select the 3D objects you want to combine, subtract, or intersect. 

3. Specify Operation: 

○ UNION: Combines the selected objects into a single, unified object. 

○ SUBTRACT: Removes the volume of the second object from the first object. 

○ INTERSECT: Creates a new object that represents the overlapping volume of the 

selected objects. 

4. Complete the Command: 

○ Press Enter to complete the operation. 
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Example: Creating a T-Shaped Object 

1. Create Two Cubes: Create two identical cubes. 

2. Align the Cubes: Position the cubes so that they intersect along one face. 

3. Use the UNION Command: 

○ Type "UNION" and press Enter. 

○ Select both cubes. 

○ Press Enter to create a single T-shaped object. 
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AutoCAD में 3D कम्पोट्जर कमािंड: 

AutoCAD में 3D कम्पोर्िर कम ांड एक बहुमुिी उपकरण है िो आपको िर्रल 3D ऑबे्जक्ट बन ने 

के र्लए कई 3D ठोस, सतहोां य  िेत्रोां को सांयोर्ित, घर न  य  प्रर्तचे्छर्दत करने की अनुमर्त देत  है। यह 

मौिूद  3D तत्वोां के िॉलू्यम में हेरफेर करके िर्रल आकृर्तयोां और मॉडलोां को बन ने के र्लए आिश्यक 

है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कम ांड ल इन में "UNION," "SUBTRACT," य  "INTERSECT" र इप करें  और Enter 

दब एां । 

○ िैकख्यल्पक रूप से, 3D मॉडर्लांग क यािेत्र में सांबांर्धत आइकन पर ख्यिक करें। 

2. ऑबे्जक्ट का चर्न करें : 

○ उन 3D ऑबे्जक््टस क  चयन करें  र्िन्हें आप सांयोर्ित, घर न  य  प्रर्तचे्छर्दत करन  च हते 

हैं। 

3. ऑपरेिन ट्नट्दाष्ट करें : 

○ UNION: चयर्नत िसु्तओां को एकल, एकीकृत िसु्त में िोड़त  है। 

○ SUBTRACT: पहली िसु्त से दूसरी िसु्त के आयतन को हर  देत  है। 

○ INTERSECT: एक नई िसु्त बन त  है िो चयर्नत िसु्तओां के अर्तव्य पी आयतन क  

प्रर्तर्नर्धत्व करत  है। 

4. कमािंड पूरा करें : 

○ ऑपरेशन को पूर  करने के र्लए Enter दब एां । 
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उदाहरण: री-आकार की िसु्त बनाना 

1. दो कू्यब्स बनाएिं : दो सम न कू्ब्स बन एां । 

2. कू्यब्स को सिंरेखित करें : कू्ब्स को इस तरह से रिें र्क िे एक चेहरे के स थ प्रर्तचे्छद करें। 

3. UNION कमािंड का उपर्ोग करें : 

○ "UNION" र इप करें  और Enter दब एां । 

○ दोनोां कू्ब्स क  चयन करें। 

○ एकल री-आक र की िसु्त बन ने के र्लए Enter दब एां । 
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PART EDITING TOOL/MODIFY TOOL IN AUTOCAD 

1. Erase   8. Trim 

2. Move   9. Extend 

3. copy    10. fillet 

4. Rotate   11. Chamfer 

5. Minor   12. Draft 

6. Array   13. Boolean 

7. Scale. 

3D Erase Command in AutoCAD: 

The 3D Erase command in AutoCAD is used to remove or delete objects from your 3D 

drawing. This is essential for cleaning up your model and ensuring accuracy. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "ERASE" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "Erase" in the "Modify" panel. 

2. Select Objects: 

○ Select Individual Objects: Click on each object you want to erase. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

○ Last (L): Erase the last object you drew. 

○ Previous (P): Erase the last set of objects you selected. 

○ All (ALL): Erase all objects in the drawing (use with caution!). 

3. Confirm Erasure: 

○ Press Enter to confirm the erasure. 
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Example: 

Let's say you have a 3D model of a house and you want to remove a window that was placed 

incorrectly. 

1. Access the Erase Command: Type "ERASE" and press Enter. 

2. Select the Window: Click on the window object. 

3. Confirm Erasure: Press Enter. 

The window will be removed from your model. 

AutoCAD में 3D इरेज़ कमािंड: 

AutoCAD में 3D इरेज़ कम ांड क  उपयोग आपके 3D डि  इांग से ऑबे्जक््टस को हर ने य  र्डलीर करने 

के र्लए र्कय  ि त  है। यह आपके मॉडल को स फ करने और सरीकत  सुर्नर्ित करने के र्लए 

आिश्यक है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "ERASE" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "Erase" पर ख्यिक करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप इरेज़ करन  च हते हैं, 

उन पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

○ अिंट्तम (L): आपके द्व र  बन ए गए अांर्तम ऑबे्जक्ट को इरेज़ करें। 

○ ट्पछ ा (P): आपके द्व र  चुने गए अांर्तम ऑबे्जक््टस के सेर को इरेज़ करें। 

○ सभी (ALL): डि  इांग में सभी ऑबे्जक््टस को इरेज़ करें  (स िध नी से उपयोग करें !)। 

3. इरेज़र की पुट्ष्ट करें : 

○ इरेज़र की पुर्ि करने के र्लए Enter दब एां । 
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उदाहरण: 

म न लीर्िए आपके प स एक घर क  3D मॉडल है और आप एक ख्यिड़की को हर न  च हते हैं र्िसे गलत 

तरीके से रि  गय  थ । 

1. इरेज़ कमािंड तक पहिंचें: "ERASE" र इप करें  और Enter दब एां । 

2. ट्ििंडो का चर्न करें : र्िांडो ऑबे्जक्ट पर ख्यिक करें। 

3. इरेज़र की पुट्ष्ट करें : Enter दब एां । 

र्िांडो आपके मॉडल से हर  दी ि एगी। 

3D Move Command in AutoCAD: 

The 3D Move command in AutoCAD allows you to move 3D objects or components in a three-

dimensional space. This is essential for positioning objects accurately within your 3D model. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "3DMOVE" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "3D Move" in the "Modify" panel. 

2. Select Objects: 

○ Select Individual Objects: Click on each object you want to move. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

3. Specify Base Point: 

○ The command line will prompt you to "Specify base point or displacement." Click 

on a point in your drawing to define the base point for the move. This point acts 

as the origin for the movement. 
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4. Specify Displacement: 

○ The command line will then prompt you to "Specify second point of 

displacement." Click on a second point in your drawing to define the distance and 

direction for the move. The selected objects will be moved to this new location. 

 

Example: 

Let's say you have a 3D model of a table and you want to move it to a different location in the 

room. 

1. Access the 3D Move Command: Type "3DMOVE" and press Enter. 

2. Select the Table: Click on the table object. 

3. Specify Base Point: Click on the center of the table's base. 

4. Specify Displacement: 

○ Click on the desired location in the room where you want to move the table. 

The table will be moved to the specified location, maintaining its original orientation. 

AutoCAD में 3D मूि कमािंड: 

AutoCAD में 3D मूि कम ांड आपको तीन-आय मी स्थ न में 3D ऑबे्जक््टस य  घरकोां को स्थ न ांतररत 

करने की अनुमर्त देत  है। यह आपके 3D मॉडल के भीतर ऑबे्जक््टस को सरीक रूप से पोर्िशन करने 

के र्लए आिश्यक है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "3DMOVE" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "3D Move" पर ख्यिक 

करें। 
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2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप स्थ न ांतररत करन  च हते 

हैं, उन पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. बेस पॉइिंर ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "बेस पॉइांर य  र्िस्थ पन र्नर्दाि करें" क  सांकेत देगी। मूि के र्लए 

बेस पॉइांर पररभ र्षत करने के र्लए अपने डि  इांग में र्कसी र्बांदु पर ख्यिक करें। यह र्बांदु 

आांदोलन के र्लए मूल के रूप में क या करत  है। 

4. ट्िस्थापन ट्नट्दाष्ट करें : 

○ कम ांड ल इन र्फर आपको "र्िस्थ पन क  दूसर  र्बांदु र्नर्दाि करें" क  सांकेत देगी। मूि के 

र्लए दूरी और र्दश  पररभ र्षत करने के र्लए अपने डि  इांग में दूसरे र्बांदु पर ख्यिक करें। 

चयर्नत ऑबे्जक््टस को इस नए स्थ न पर ले ि य  ि एग । 

 

उदाहरण: 

म न लीर्िए आपके प स एक रेबल क  3D मॉडल है और आप इसे कमरे में एक अलग स्थ न पर ले ि न  

च हते हैं। 

1. 3D मूि कमािंड तक पहिंचें: "3DMOVE" र इप करें  और Enter दब एां । 

2. रेब  का चर्न करें : रेबल ऑबे्जक्ट पर ख्यिक करें। 

3. बेस पॉइिंर ट्नट्दाष्ट करें : रेबल के आध र के कें द्र पर ख्यिक करें। 

4. ट्िस्थापन ट्नट्दाष्ट करें : 

○ उस स्थ न पर ख्यिक करें  िह ां आप रेबल को ले ि न  च हते हैं। 

रेबल को र्नर्दाि स्थ न पर ले ि य  ि एग , इसके मूल अर्भर्िन्य स को बन ए रिते हुए। 
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3D Copy Command in AutoCAD: 

The 3D Copy command in AutoCAD allows you to create identical copies of 3D objects in 

your drawing. This is useful for creating multiple instances of the same object, such as 

replicating furniture in a room or creating a pattern of objects. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "COPY" and press Enter. 

○ Ribbon: Click on the "Home" tab, then "Copy" in the "Clipboard" panel. 

2. Select Objects: 

○ Select Individual Objects: Click on each object you want to copy. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

3. Specify Base Point: 

○ The command line will prompt you to "Specify base point or displacement." Click 

on a point in your drawing to define the base point for the copy. This point acts as 

the origin for the copied objects. 

4. Specify Displacement: 

○ The command line will then prompt you to "Specify second point of 

displacement." Click on a second point in your drawing to define the distance and 

direction for the copy. The copied objects will be placed at this new location, 

maintaining their orientation relative to the base point. 

 

Example: 

Let's say you have a 3D model of a chair and you want to create two more copies of it, arranged 

in a row. 
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1. Access the Copy Command: Type "COPY" and press Enter. 

2. Select the Chair: Click on the chair object. 

3. Specify Base Point: Click on the bottom center of the chair's base. 

4. Specify Displacement: 

○ Click on a point slightly to the right of the chair to create the first copy. 

○ Click on another point to the right of the first copy to create the second copy. 

The two copies of the chair will be created, maintaining the same orientation as the original. 

AutoCAD में 3D कॉपी कमािंड: 

AutoCAD में 3D कॉपी कम ांड आपको अपने डि  इांग में 3D ऑबे्जक््टस की सम न प्रर्तय ाँ बन ने की 

अनुमर्त देत  है। यह र्कसी एक ऑबे्जक्ट के कई इांस्टेंस बन ने के र्लए उपयोगी है, िैसे र्क र्कसी कमरे 

में फनीचर की नकल करन  य  ऑबे्जक््टस क  पैरना बन न । 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "COPY" र इप करें  और Enter दब एां । 

○ ररबन: "Home" रैब पर ख्यिक करें , र्फर "Clipboard" पैनल में "Copy" पर ख्यिक करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप कॉपी करन  च हते हैं, 

उन पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. बेस पॉइिंर ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "बेस पॉइांर य  र्िस्थ पन र्नर्दाि करें" क  सांकेत देगी। कॉपी के र्लए 

बेस पॉइांर पररभ र्षत करने के र्लए अपने डि  इांग में र्कसी र्बांदु पर ख्यिक करें। यह र्बांदु 

कॉपी र्कए गए ऑबे्जक््टस के र्लए मूल के रूप में क या करत  है। 

4. ट्िस्थापन ट्नट्दाष्ट करें : 

○ कम ांड ल इन र्फर आपको "र्िस्थ पन क  दूसर  र्बांदु र्नर्दाि करें" क  सांकेत देगी। कॉपी 

के र्लए दूरी और र्दश  पररभ र्षत करने के र्लए अपने डि  इांग में दूसरे र्बांदु पर ख्यिक करें। 

कॉपी र्कए गए ऑबे्जक््टस को इस नए स्थ न पर रि  ि एग , बेस पॉइांर के स पेि उनके 

ओररएां रेशन को बन ए रिते हुए। 



 

46 
 

 

उदाहरण: 

म न लीर्िए आपके प स एक कुसी क  3D मॉडल है और आप इसकी दो और प्रर्तय ाँ बन न  च हते हैं, 

र्िन्हें एक पांख्यक्त में व्यिख्यस्थत र्कय  गय  है। 

1. कॉपी कमािंड तक पहिंचें: "COPY" र इप करें  और Enter दब एां । 

2. कुसी का चर्न करें : कुसी ऑबे्जक्ट पर ख्यिक करें। 

3. बेस पॉइिंर ट्नट्दाष्ट करें : कुसी के आध र के र्नचले कें द्र पर ख्यिक करें। 

4. ट्िस्थापन ट्नट्दाष्ट करें : 

○ पहली प्रर्तर्लर्प बन ने के र्लए कुसी के द ईां ओर थोड़  स  र्बांदु पर ख्यिक करें। 

○ दूसरी प्रर्त बन ने के र्लए पहली प्रर्त के द ईां ओर एक अन्य र्बांदु पर ख्यिक करें। 

कुसी की दो प्रर्तय ाँ बन ई ि एां गी, मूल के सम न अर्भर्िन्य स बन ए रिते हुए। 

3D Rotate Command in AutoCAD: 

The 3D Rotate command in AutoCAD allows you to rotate 3D objects around a specified axis. 

This is crucial for accurately positioning and orienting objects within your 3D model. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "3DROTATE" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "3D Rotate" in the "Modify" panel. 

2. Select Objects: 

○ Select Individual Objects: Click on each object you want to rotate. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 
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3. Specify Base Point: 

○ The command line will prompt you to "Specify base point or displacement." Click 

on a point in your drawing to define the base point for the rotation. This point acts 

as the origin for the rotation. 

4. Specify Axis: 

○ The command line will then prompt you to "Specify start point of axis." Click on 

a point to define the starting point of the rotation axis. 

○ Next, the command line will prompt you to "Specify end point of axis." Click on 

another point to define the end point of the rotation axis. The objects will rotate 

around this axis. 

5. Specify Rotation Angle: 

○ The command line will prompt you to "Specify rotation angle." Enter the desired 

rotation angle in degrees. 

 

Example: 

Let's say you have a 3D model of a door and you want to rotate it 90 degrees around its vertical 

axis. 

1. Access the 3D Rotate Command: Type "3DROTATE" and press Enter. 

2. Select the Door: Click on the door object. 

3. Specify Base Point: Click on the center point of the door's base. 

4. Specify Axis: 

○ Click on the bottom of the door's hinge. 

○ Click on the top of the door's hinge. 

5. Specify Rotation Angle: Enter "90" and press Enter. 



 

48 
 

The door will rotate 90 degrees around its vertical axis, effectively opening it. 

AutoCAD में 3D रोरेर कमािंड: 

AutoCAD में 3D रोरेर कम ांड आपको र्कसी र्नर्दाि अि के च रोां ओर 3D ऑबे्जक््टस को घुम ने की 

अनुमर्त देत  है। यह आपके 3D मॉडल के भीतर ऑबे्जक््टस को सरीक रूप से पोर्िशन और ओररएां र 

करने के र्लए महत्वपूणा है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "3DROTATE" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "3D Rotate" पर ख्यिक 

करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप घुम न  च हते हैं, उन पर 

ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. बेस पॉइिंर ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "बेस पॉइांर य  र्िस्थ पन र्नर्दाि करें" क  सांकेत देगी। रोरेशन के 

र्लए बेस पॉइांर पररभ र्षत करने के र्लए अपने डि  इांग में र्कसी र्बांदु पर ख्यिक करें। यह 

र्बांदु रोरेशन के र्लए मूल के रूप में क या करत  है। 

4. अक्ष ट्नट्दाष्ट करें : 

○ कम ांड ल इन र्फर आपको "अि क  प्र रां र्भक र्बांदु र्नर्दाि करें" क  सांकेत देगी। रोरेशन 

अि के प्र रां र्भक र्बांदु को पररभ र्षत करने के र्लए र्कसी र्बांदु पर ख्यिक करें। 

○ इसके ब द, कम ांड ल इन आपको "अि क  अांर्तम र्बांदु र्नर्दाि करें" क  सांकेत देगी। 

रोरेशन अि के अांर्तम र्बांदु को पररभ र्षत करने के र्लए र्कसी अन्य र्बांदु पर ख्यिक करें। 

ऑबे्जक््टस इस अि के च रोां ओर घूमेंगे। 

5. रोरेिन कोण ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "रोरेशन कोण र्नर्दाि करें" क  सांकेत देगी। र्डग्री में ि ांर्ित रोरेशन 

कोण दिा करें। 
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उदाहरण: 

म न लीर्िए आपके प स एक दरि िे क  3D मॉडल है और आप इसे उसके ऊर्ध् ाधर अि के च रोां ओर 

90 र्डग्री घुम न  च हते हैं। 

1. 3D रोरेर कमािंड तक पहिंचें: "3DROTATE" र इप करें  और Enter दब एां । 

2. दरिाजे का चर्न करें : दरि ि  ऑबे्जक्ट पर ख्यिक करें। 

3. बेस पॉइिंर ट्नट्दाष्ट करें : दरि िे के आध र के कें द्र र्बांदु पर ख्यिक करें। 

4. अक्ष ट्नट्दाष्ट करें : 

○ दरि िे के क ि के र्नचले र्हसे्स पर ख्यिक करें। 

○ दरि िे के क ि के शीषा पर ख्यिक करें। 

5. रोरेिन कोण ट्नट्दाष्ट करें : "90" दिा करें  और Enter दब एां । 

दरि ि  अपने ऊर्ध् ाधर अि के च रोां ओर 90 र्डग्री घूमेग , प्रभ िी ढांग से इसे िोल देग । 

3D Mirror Command in AutoCAD: 

The 3D Mirror command in AutoCAD creates a mirrored copy of 3D objects across a specified 

plane. This is useful for creating symmetrical designs, duplicating objects, or modifying 

existing 3D models. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "3DMIRROR" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "3D Mirror" in the "Modify" panel. 

2. Select Objects: 
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○ Select Individual Objects: Click on each object you want to mirror. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

3. Specify Mirror Plane: 

○ The command line will prompt you to define the mirror plane. You can do this in 

a few ways: 

■ Three Points: Specify three points in space to define the plane. 

■ Object: Select a planar object, and the command will use its plane as the 

mirror plane. 

■ Predefined Planes: Select from predefined planes like XY, YZ, or ZX. 

4. Delete Original Objects: 

○ The command line will ask "Delete source objects?" 

■ Enter "Y" to delete the original objects after mirroring. 

■ Enter "N" or press Enter to keep the original objects. 

 

Example: 

Let's say you have a 3D model of a chair and you want to create a mirrored copy to simulate a 

pair of chairs facing each other. 

1. Access the 3D Mirror Command: Type "3DMIRROR" and press Enter. 

2. Select the Chair: Click on the chair object. 

3. Specify Mirror Plane: 

○ Method 1 (Three Points): Click on three points that define the plane you want to 

mirror across. For example, you could click on three points on the floor in front of 

the chair. 
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○ Method 2 (Predefined Plane): Select "XY" to mirror across the XY plane (the 

floor). 

4. Delete Original Objects: Enter "N" to keep the original chair. 

The command will create a mirrored copy of the chair on the opposite side of the specified 

plane. 

AutoCAD में 3D ट्मरर कमािंड: 

AutoCAD में 3D र्मरर कम ांड र्कसी र्नर्दाि पे्लन के प र 3D ऑबे्जक््टस की एक र्मरर कॉपी बन त  

है। यह समर्मतीय र्डज़ इन बन ने, ऑबे्जक््टस को डुख्यप्लकेर करने य  मौिूद  3D मॉडल को सांशोर्धत 

करने के र्लए उपयोगी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "3DMIRROR" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "3D Mirror" पर ख्यिक 

करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप र्मरर करन  च हते हैं, 

उन पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. ट्मरर पे्लन ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको र्मरर पे्लन को पररभ र्षत करने के र्लए पे्रररत करेगी। आप इसे कुि 

तरीकोां से कर सकते हैं: 

■ तीन ट्बिंदु: पे्लन को पररभ र्षत करने के र्लए अांतररि में तीन र्बांदु र्नर्दाि करें । 

■ ऑबे्जक्ट: र्कसी प्ल नर ऑबे्जक्ट क  चयन करें , और कम ांड इसके पे्लन को र्मरर 

पे्लन के रूप में उपयोग करेग । 

■ पूिाट्नधााररत पे्लन: XY, YZ, य  ZX िैसे पूिार्नध ाररत पे्लन में से चुनें। 

4. मू  ऑबे्जक््टस हराएिं : 

○ कम ांड ल इन पूिेगी "मूल ऑबे्जक््टस हर एां ?" 

■ र्मरररांग के ब द मूल ऑबे्जक््टस को हर ने के र्लए "Y" दिा करें। 
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■ मूल ऑबे्जक््टस रिने के र्लए "N" दिा करें  य  Enter दब एां । 

 

उदाहरण: 

म न लीर्िए आपके प स एक कुसी क  3D मॉडल है और आप एक दूसरे क  स मन  करने ि ली कुर्सायोां 

की एक िोड़ी क  अनुकरण करने के र्लए एक र्मरर कॉपी बन न  च हते हैं। 

1. 3D ट्मरर कमािंड तक पहिंचें: "3DMIRROR" र इप करें  और Enter दब एां । 

2. कुसी का चर्न करें : कुसी ऑबे्जक्ट पर ख्यिक करें। 

3. ट्मरर पे्लन ट्नट्दाष्ट करें : 

○ ट्िट्ध 1 (तीन ट्बिंदु): उन तीन र्बांदुओां पर ख्यिक करें  िो उस पे्लन को पररभ र्षत करते हैं 

र्िसके प र आप र्मरर करन  च हते हैं। उद हरण के र्लए, आप कुसी के स मने फशा पर 

तीन र्बांदुओां पर ख्यिक कर सकते हैं। 

○ ट्िट्ध 2 (पूिाट्नधााररत पे्लन): XY पे्लन (फशा) के प र र्मरर करने के र्लए "XY" चुनें। 

4. मू  ऑबे्जक््टस हराएिं : मूल कुसी रिने के र्लए "N" दिा करें। 

कम ांड र्नर्दाि पे्लन के र्िपरीत र्दश  में कुसी की एक र्मरर कॉपी बन एग । 

3D Array Command in AutoCAD: 

The 3D Array command in AutoCAD allows you to create multiple copies of objects in a three-

dimensional pattern. This is incredibly useful for creating repetitive elements like grids of 

columns, rows of seats, or complex structures with repeating components. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "3DARRAY" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "Array" in the "Modify" panel, and select 

"3D Array." 
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2. Select Objects: 

○ Select Individual Objects: Click on each object you want to array. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

3. Choose Array Type: 

○ Rectangular Array: Creates copies in a grid pattern along the X, Y, and Z axes. 

○ Polar Array: Creates copies around a center point, rotating them around a 

specified axis. 

4. Define Array Parameters (Rectangular): 

○ Rows: Specify the number of rows in the array. 

○ Columns: Specify the number of columns in the array. 

○ Levels: Specify the number of levels in the array (for depth). 

○ Row Offset: Define the distance between rows. 

○ Column Offset: Define the distance between columns. 

○ Level Offset: Define the distance between levels. 

5. Define Array Parameters (Polar): 

○ Center Point: Specify the center point of the array. 

○ Axis: Specify two points to define the axis of rotation. 

○ Number of Items: Specify the number of copies to create. 

○ Angle to Fill: Specify the angle to fill with copies. 
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Example: 

Let's say you want to create a grid of 3x3 columns in a building. 

1. Access the 3D Array Command: Type "3DARRAY" and press Enter. 

2. Select the Column: Select the 3D model of a single column. 

3. Choose Rectangular Array: Press Enter to accept the default "Rectangular" array type. 

4. Define Parameters: 

○ Rows: Enter "3." 

○ Columns: Enter "3." 

○ Levels: Enter "1" (since it's a 2D grid). 

○ Row Offset: Enter the desired distance between columns. 

○ Column Offset: Enter the desired distance between rows. 

○ Level Offset: Leave this at 0. 

The command will create a 3x3 grid of columns, spaced according to the specified offsets. 

AutoCAD में 3D एरे कमािंड: 

AutoCAD में 3D एरे कम ांड आपको तीन-आय मी पैरना में ऑबे्जक््टस की कई प्रर्तय ां बन ने की अनुमर्त 

देत  है। यह स्तांभोां के र्ग्रड, सीरोां की पांख्यक्तयोां य  दोहर ि ि ले घरकोां ि ली िर्रल सांरचन ओां िैसे दोहर ि 

ि ले तत्वोां को बन ने के र्लए अर्िश्वसनीय रूप से उपयोगी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "3DARRAY" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "Array" पर ख्यिक करें , 

और "3D Array" क  चयन करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप एरे करन  च हते हैं, उन 

पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. एरे प्रकार चुनें: 
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○ आर्ताकार एरे: X, Y और Z अिोां के स थ र्ग्रड पैरना में प्रर्तय ां बन त  है। 

○ धु्रिीर् एरे: एक कें द्र र्बांदु के च रोां ओर प्रर्तय ां बन त  है, उन्हें एक र्नर्दाि अि के च रोां ओर 

घुम त  है। 

4. एरे पैरामीरर पररभाट्ित करें  (आर्ताकार): 

○ पिंखक्तर्ााँ: एरे में पांख्यक्तयोां की सांि  र्नर्दाि करें। 

○ स्तिंभ: एरे में स्तांभोां की सांि  र्नर्दाि करें। 

○ स्तर: एरे में स्तरोां की सांि  र्नर्दाि करें  (गहर ई के र्लए)। 

○ पिंखक्त ऑफसेर: पांख्यक्तयोां के बीच की दूरी पररभ र्षत करें। 

○ स्तिंभ ऑफसेर: स्तांभोां के बीच की दूरी पररभ र्षत करें। 

○ स्तर ऑफसेर: स्तरोां के बीच की दूरी पररभ र्षत करें। 

5. एरे पैरामीरर पररभाट्ित करें  (धु्रिीर्): 

○ कें द्र ट्बिंदु: एरे क  कें द्र र्बांदु र्नर्दाि करें। 

○ अक्ष: रोरेशन के अि को पररभ र्षत करने के र्लए दो र्बांदु र्नर्दाि करें। 

○ आइरम की सिंख्या: बन ने के र्लए प्रर्तयोां की सांि  र्नर्दाि करें। 

○ भरने के ट् ए कोण: प्रर्तयोां से भरने के र्लए कोण र्नर्दाि करें। 

 

उदाहरण: 

म न लीर्िए आप र्कसी भिन में 3x3 स्तांभोां क  एक र्ग्रड बन न  च हते हैं। 

1. 3D एरे कमािंड तक पहिंचें: "3DARRAY" र इप करें  और Enter दब एां । 
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2. स्तिंभ का चर्न करें : एकल स्तांभ के 3D मॉडल क  चयन करें। 

3. आर्ताकार एरे चुनें: र्डफॉल्ट "आयत क र" एरे प्रक र स्वीक र करने के र्लए Enter दब एां । 

4. पैरामीरर पररभाट्ित करें : 

○ पिंखक्तर्ााँ: "3" दिा करें। 

○ स्तिंभ: "3" दिा करें। 

○ स्तर: "1" दिा करें  (चूांर्क यह 2D र्ग्रड है)। 

○ पिंखक्त ऑफसेर: स्तांभोां के बीच की ि ांर्ित दूरी दिा करें। 

○ स्तिंभ ऑफसेर: पांख्यक्तयोां के बीच की ि ांर्ित दूरी दिा करें। 

○ स्तर ऑफसेर: इसे 0 पर िोड़ दें। 

कम ांड र्नर्दाि ऑफसेर के अनुस र स्तांभोां क  3x3 र्ग्रड बन एग । 

3D Scale Command in AutoCAD: 

The 3D Scale command in AutoCAD allows you to resize 3D objects uniformly or along 

specific axes. This is crucial for adjusting the size and proportions of objects within your 3D 

model. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "3DSCALE" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "3D Scale" in the "Modify" panel. 

2. Select Objects: 

○ Select Individual Objects: Click on each object you want to scale. 

○ Window/Crossing Selection: Use a window or crossing selection to select 

multiple objects at once. 

3. Specify Base Point: 

○ The command line will prompt you to "Specify base point." Click on a point in 

your drawing to define the base point for the scaling. This point acts as the origin 

for the scaling operation. 

4. Specify Scale Factors: 

○ Uniform Scaling: 
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■ Enter a uniform scale factor (e.g., "2" to double the size, "0.5" to halve the 

size). 

○ Non-uniform Scaling: 

■ The command line will prompt you for scale factors along the X, Y, and Z 

axes. Enter the desired scale factor for each axis. 

 

Example: 

Let's say you have a 3D model of a cube and you want to double its size. 

1. Access the 3D Scale Command: Type "3DSCALE" and press Enter. 

2. Select the Cube: Click on the cube object. 

3. Specify Base Point: Click on the center of the cube. 

4. Specify Scale Factor: Enter "2" and press Enter. 

The cube will be scaled uniformly in all directions, doubling its size while maintaining its 

original proportions and center point. 

AutoCAD में 3D से्क  कमािंड: 

AutoCAD में 3D से्कल कम ांड आपको 3D ऑबे्जक््टस क  आक र सम न रूप से य  र्िर्शि अिोां के 

स थ बदलने की अनुमर्त देत  है। यह आपके 3D मॉडल के भीतर ऑबे्जक््टस के आक र और अनुप त 

को सम योर्ित करने के र्लए महत्वपूणा है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "3DSCALE" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "3D Scale" पर ख्यिक 

करें। 
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2. ऑबे्जक््टस का चर्न करें : 

○ व्यखक्तगत ऑबे्जक््टस का चर्न करें : र्िन ऑबे्जक््टस को आप से्कल करन  च हते हैं, 

उन पर ख्यिक करें। 

○ ट्ििंडो/िॉट्सिंग चर्न: एक ब र में कई ऑबे्जक््टस क  चयन करने के र्लए र्िांडो य  िॉर्सांग 

चयन क  उपयोग करें । 

3. बेस पॉइिंर ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "बेस पॉइांर र्नर्दाि करें" क  सांकेत देगी। से्कर्लांग के र्लए बेस पॉइांर 

पररभ र्षत करने के र्लए अपने डि  इांग में र्कसी र्बांदु पर ख्यिक करें। यह र्बांदु से्कर्लांग 

ऑपरेशन के र्लए मूल के रूप में क या करत  है। 

4. से्क  फैक्टर ट्नट्दाष्ट करें : 

○ समान से्कट् िंग: 

■ एक सम न से्कल फैक्टर दिा करें  (िैसे, आक र को दोगुन  करने के र्लए "2", 

आक र को आध  करने के र्लए "0.5")। 

○ असमान से्कट् िंग: 

■ कम ांड ल इन आपको X, Y और Z अिोां के स थ से्कल फैक्टर के र्लए सांकेत देगी। 

प्रते्यक अि के र्लए ि ांर्ित से्कल फैक्टर दिा करें। 

 

उदाहरण: 

म न लीर्िए आपके प स एक घन क  3D मॉडल है और आप इसके आक र को दोगुन  करन  च हते हैं। 

1. 3D से्क  कमािंड तक पहिंचें: "3DSCALE" र इप करें  और Enter दब एां । 

2. घन का चर्न करें : घन ऑबे्जक्ट पर ख्यिक करें। 

3. बेस पॉइिंर ट्नट्दाष्ट करें : घन के कें द्र पर ख्यिक करें। 
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4. से्क  फैक्टर ट्नट्दाष्ट करें : "2" दिा करें  और Enter दब एां । 

घन को सभी र्दश ओां में सम न रूप से से्कल र्कय  ि एग , र्िससे इसक  आक र दोगुन  हो ि एग  और 

इसके मूल अनुप त और कें द्र र्बांदु को बन ए रि  ि एग । 

3D Trim Command in AutoCAD: 

The 3D Trim command in AutoCAD allows you to shorten or remove portions of 3D objects 

by intersecting them with other objects. This is essential for refining your 3D models and 

creating clean, accurate geometry. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "TRIM" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "Trim" in the "Modify" panel. 

2. Select Cutting Edges: 

○ The command line will prompt you to "Select cutting edges." Click on the edges 

of other objects that you want to use to trim the selected objects. 

■ Important: In 3D, the cutting edges must intersect the object to be trimmed 

in 3D space. 

3. Select Objects to Trim: 

○ The command line will prompt you to "Select objects to trim." Click on the objects 

that you want to shorten or remove portions of. 

 

Example: 

Imagine you have a 3D model of a box. You want to trim a protruding corner of the box using 

the edge of another box that intersects it. 

1. Access the Trim Command: Type "TRIM" and press Enter. 
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2. Select Cutting Edge: Click on the edge of the intersecting box. 

3. Select Object to Trim: Click on the corner of the first box that you want to remove. 

The corner of the first box will be trimmed away where it intersects the edge of the second box. 

AutoCAD में 3D ट्रि म कमािंड: 

AutoCAD में 3D र्रि म कम ांड आपको अन्य ऑबे्जक््टस के स थ इांररसेक्ट करके 3D ऑबे्जक््टस के 

र्हस्सोां को िोर  करने य  हर ने की अनुमर्त देत  है। यह आपके 3D मॉडल को पररषृ्कत करने और 

स्वच्छ, सरीक ज्य र्मर्त बन ने के र्लए आिश्यक है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "TRIM" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "Trim" पर ख्यिक करें। 

2. कट्रिंग एजेज का चर्न करें : 

○ कम ांड ल इन आपको "कर्रांग एिेि क  चयन करें" सांकेत देगी। उन ऑबे्जक््टस के 

र्कन रोां पर ख्यिक करें  र्िनक  उपयोग आप चयर्नत ऑबे्जक््टस को र्रि म करने के र्लए 

करन  च हते हैं। 

■ महत्वपूणा: 3D में, कर्रांग एिेि को 3D से्पस में र्रि म र्कए ि ने ि ले ऑबे्जक्ट को 

क रन  च र्हए। 

3. ट्रि म करने के ट् ए ऑबे्जक््टस का चर्न करें : 

○ कम ांड ल इन आपको "र्रि म करने के र्लए ऑबे्जक््टस क  चयन करें" सांकेत देगी। उन 

ऑबे्जक््टस पर ख्यिक करें  र्िन्हें आप िोर  करन  य  हर न  च हते हैं। 
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उदाहरण: 

कल्पन  कीर्िए र्क आपके प स एक बॉक्स क  3D मॉडल है। आप र्कसी अन्य बॉक्स के र्कन रे क  

उपयोग करके बॉक्स के एक उभरे हुए कोने को र्रि म करन  च हते हैं िो इसे क रत  है। 

1. ट्रि म कमािंड तक पहिंचें: "TRIM" र इप करें  और Enter दब एां । 

2. कट्रिंग एज का चर्न करें : इांररसेख्यक्टांग बॉक्स के र्कन रे पर ख्यिक करें। 

3. ट्रि म करने के ट् ए ऑबे्जक्ट का चर्न करें : उस बॉक्स के कोने पर ख्यिक करें  र्िसे आप हर न  

च हते हैं। 

पहले बॉक्स क  कोन  दूसरे बॉक्स के र्कन रे से प्रर्तचे्छद करने पर र्रि म कर र्दय  ि एग । 

3D Extend Command in AutoCAD: 

The 3D Extend command in AutoCAD allows you to lengthen existing 3D objects to meet the 

edges of other objects. This is useful for creating clean and continuous connections between 

different parts of your 3D model. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "EXTEND" and press Enter. 

○ Ribbon: Click on the "Modify" tab, then "Extend" in the "Modify" panel. 

2. Select Boundary Edges: 

○ The command line will prompt you to "Select boundary edges." Click on the edges 

of other objects that you want to extend the selected objects to meet. 

■ Important: In 3D, the boundary edges must be in a position where the 

selected objects can realistically be extended to meet them. 

3. Select Objects to Extend: 

○ The command line will prompt you to "Select objects to extend." Click on the 

objects that you want to lengthen. 
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Example: 

Imagine you have a 3D model of a wall and a shelf. You want to extend the shelf so that it's 

flush against the wall. 

1. Access the Extend Command: Type "EXTEND" and press Enter. 

2. Select Boundary Edge: Click on the edge of the wall where you want the shelf to meet. 

3. Select Object to Extend: Click on the edge of the shelf that needs to be extended. 

The shelf will be extended to meet the edge of the wall, creating a seamless connection. 

AutoCAD में 3D एक्सरेंड कमािंड: 

AutoCAD में 3D एक्सरेंड कम ांड आपको मौिूद  3D ऑबे्जक््टस को अन्य ऑबे्जक््टस के र्कन रोां से 

र्मलने तक लांब  करने की अनुमर्त देत  है। यह आपके 3D मॉडल के र्िर्भन्न भ गोां के बीच स्वच्छ और 

र्नरांतर कनेक्शन बन ने के र्लए उपयोगी है। 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "EXTEND" र इप करें  और Enter दब एां । 

○ ररबन: "Modify" रैब पर ख्यिक करें , र्फर "Modify" पैनल में "Extend" पर ख्यिक करें। 

2. सीमा ट्कनारो िं का चर्न करें : 

○ कम ांड ल इन आपको "सीम  र्कन रोां क  चयन करें" सांकेत देगी। उन ऑबे्जक््टस के 

र्कन रोां पर ख्यिक करें  र्िनसे आप चयर्नत ऑबे्जक््टस को र्मलने तक बढ़ न  च हते हैं। 

■ महत्वपूणा: 3D में, सीम  र्कन रोां को ऐसी ख्यस्थर्त में होन  च र्हए िह ां चयर्नत 

ऑबे्जक््टस यथ थाि दी रूप से उनसे र्मलने तक बढ़ ए ि  सकते हैं। 

3. ट्िस्ताररत करने के ट् ए ऑबे्जक््टस का चर्न करें : 

○ कम ांड ल इन आपको "र्िस्त ररत करने के र्लए ऑबे्जक््टस क  चयन करें" सांकेत देगी। 

उन ऑबे्जक््टस पर ख्यिक करें  र्िन्हें आप लांब  करन  च हते हैं। 
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उदाहरण: 

कल्पन  कीर्िए र्क आपके प स एक दीि र और एक शेल्फ क  3D मॉडल है। आप शेल्फ को इतन  

बढ़ न  च हते हैं र्क िह दीि र से सरीक हो ि ए। 

1. एक्सरेंड कमािंड तक पहिंचें: "EXTEND" र इप करें  और Enter दब एां । 

2. सीमा ट्कनारा चुनें: दीि र के उस र्कन रे पर ख्यिक करें  िह ां आप शेल्फ को र्मलन  च हते हैं। 

3. ट्िस्ताररत करने के ट् ए ऑबे्जक्ट का चर्न करें : शेल्फ के उस र्कन रे पर ख्यिक करें  र्िसे 

बढ़ य  ि न  च र्हए। 

शेल्फ को दीि र के र्कन रे से र्मलने के र्लए बढ़ य  ि एग , र्िससे एक सहि कनेक्शन बन ि एग । 

3D Fillet Command in AutoCAD: 

The 3D Fillet command in AutoCAD creates rounded edges between two intersecting surfaces 

or between a surface and a solid object. This is essential for: 

● Improving aesthetics: Creating smoother, more visually appealing edges. 

● Enhancing functionality: Reducing stress points and improving the flow of fluids or 

materials. 

● Preparing models for manufacturing: Facilitating easier machining and assembly. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "FILLETEDGE" and press Enter. 

○ Ribbon: Click on the "Solid" tab, then "Fillet Edge" in the "Solid Editing" panel. 

2. Select Edges: 

○ The command line will prompt you to "Select first edge." Click on the first edge 

of the intersection where you want to create the fillet. 

○ The command line will then prompt you to "Select second edge." Click on the 

second edge of the intersection. 

3. Specify Fillet Radius: 

○ The command line will prompt you to "Enter fillet radius." Enter the desired radius 

for the fillet. 
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Example: 

Let's say you have a 3D model of a box with sharp corners. You want to create rounded edges 

at the corners to improve its appearance. 

1. Access the Fillet Edge Command: Type "FILLETEDGE" and press Enter. 

2. Select Edges: Click on the two edges that form the first corner. 

3. Specify Fillet Radius: Enter the desired radius for the fillet (e.g., "5"). 

The command will create a rounded edge at the selected corner. You can repeat this process to 

create fillets at other corners of the box. 

AutoCAD में 3D ट्फ ेर कमािंड: 

AutoCAD में 3D र्फलेर कम ांड दो प्रर्तचे्छदी सतहोां के बीच य  र्कसी सतह और र्कसी ठोस िसु्त के 

बीच गोल र्कन रे बन त  है। यह इन उदे्दश्योां के र्लए आिश्यक है: 

● स िंदर्ािास्त्र में सुधार: र्चकने, अर्धक दृर्िगत रूप से आकषाक र्कन रे बन न । 

● कार्ाक्षमता बढाना: तन ि र्बांदुओां को कम करन  और तरल पद थों य  स मर्ग्रयोां के प्रि ह में 

सुध र करन । 

● ट्िट्नमााण के ट् ए मॉड  तैर्ार करना: आस न मशीर्नांग और असेंबली की सुर्िध  प्रद न 

करन । 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "FILLETEDGE" र इप करें  और Enter दब एां । 

○ ररबन: "Solid" रैब पर ख्यिक करें , र्फर "Solid Editing" पैनल में "Fillet Edge" पर 
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ख्यिक करें। 

2. ट्कनारो िं का चर्न करें : 

○ कम ांड ल इन आपको "पहल  र्कन र  चुनें" सांकेत देगी। उस चौर हे के पहले र्कन रे पर 

ख्यिक करें  िह ां आप र्फलेर बन न  च हते हैं। 

○ कम ांड ल इन र्फर आपको "दूसर  र्कन र  चुनें" सांकेत देगी। चौर हे के दूसरे र्कन रे पर 

ख्यिक करें। 

3. ट्फ ेर ट्िज्या ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "र्फलेर र्त्रज्य  दिा करें" सांकेत देगी। र्फलेर के र्लए ि ांर्ित र्त्रज्य  

दिा करें। 

 

उदाहरण: 

म न लीर्िए आपके प स एक बॉक्स क  3D मॉडल है और आप इसके कोनोां पर गोल र्कन रे बन न  

च हते हैं त र्क इसकी उपख्यस्थर्त में सुध र हो सके। 

1. ट्फ ेर एज कमािंड तक पहिंचें: "FILLETEDGE" र इप करें  और Enter दब एां । 

2. ट्कनारो िं का चर्न करें : पहले कोने बन ने ि ले दो र्कन रोां पर ख्यिक करें। 

3. ट्फ ेर ट्िज्या ट्नट्दाष्ट करें : र्फलेर के र्लए ि ांर्ित र्त्रज्य  दिा करें  (िैसे, "5")। 

कम ांड चयर्नत कोने पर एक गोल र्कन र  बन एग । आप बॉक्स के अन्य कोनोां पर र्फलेर बन ने के र्लए 

इस प्रर्िय  को दोहर  सकते हैं। 

3D Chamfer Command in AutoCAD: 

The 3D Chamfer command in AutoCAD creates angled edges or bevels between two 

intersecting surfaces or between a surface and a solid object. This is useful for: 
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● Improving aesthetics: Creating angled edges for a more industrial or mechanical look. 

● Enhancing functionality: Reducing stress points and improving the flow of fluids or 

materials in certain applications. 

● Preparing models for manufacturing: Facilitating easier machining and assembly. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "CHAMFEREDGE" and press Enter. 

○ Ribbon: Click on the "Solid" tab, then "Chamfer Edge" in the "Solid Editing" 

panel. 

2. Specify Chamfer Distances: 

○ The command line will prompt you to "Specify first chamfer distance." Enter the 

desired distance for the first chamfer cut. 

○ The command line will then prompt you to "Specify second chamfer distance." 

Enter the desired distance for the second chamfer cut (if different from the first). 

If you want equal distances, simply press Enter. 

3. Select Edges: 

○ The command line will prompt you to "Select first edge." Click on the first edge 

of the intersection where you want to create the chamfer. 

○ The command line will then prompt you to "Select second edge." Click on the 

second edge of the intersection. 

 

Example: 

Let's say you have a 3D model of a box with sharp corners. You want to create angled edges at 

the corners to give it a more mechanical appearance. 
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1. Access the Chamfer Edge Command: Type "CHAMFEREDGE" and press Enter. 

2. Specify Chamfer Distances: Enter "2" for both distances to create equal chamfer cuts. 

3. Select Edges: Click on the two edges that form the first corner. 

The command will create an angled edge at the selected corner. You can repeat this process to 

create chamfers at other corners of the box. 

AutoCAD में 3D चैंफर कमािंड: 

AutoCAD में 3D चैंफर कम ांड दो प्रर्तचे्छदी सतहोां के बीच य  र्कसी सतह और र्कसी ठोस िसु्त के 

बीच कोण ि ले र्कन रे य  बेिल्स बन त  है। यह इन उदे्दश्योां के र्लए उपयोगी है: 

● स िंदर्ािास्त्र में सुधार: अर्धक औद्योर्गक य  य ांर्त्रक रूप के र्लए कोण ि ले र्कन रे बन न । 

● कार्ाक्षमता बढाना: तन ि र्बांदुओां को कम करन  और कुि अनुप्रयोगोां में तरल पद थों य  

स मर्ग्रयोां के प्रि ह में सुध र करन । 

● ट्िट्नमााण के ट् ए मॉड  तैर्ार करना: आस न मशीर्नांग और असेंबली की सुर्िध  प्रद न 

करन । 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "CHAMFEREDGE" र इप करें  और Enter दब एां । 

○ ररबन: "Solid" रैब पर ख्यिक करें , र्फर "Solid Editing" पैनल में "Chamfer Edge" पर 

ख्यिक करें। 

2. चैंफर दूररर्ािं ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "पहली चैंफर दूरी र्नर्दाि करें" सांकेत देगी। पहली चैंफर कर के 

र्लए ि ांर्ित दूरी दिा करें। 

○ कम ांड ल इन र्फर आपको "दूसरी चैंफर दूरी र्नर्दाि करें" सांकेत देगी। दूसरी चैंफर कर 

के र्लए ि ांर्ित दूरी दिा करें  (यर्द पहली से र्भन्न है)। यर्द आप सम न दूरी च हते हैं, तो 

बस Enter दब एां । 

3. ट्कनारो िं का चर्न करें : 

○ कम ांड ल इन आपको "पहल  र्कन र  चुनें" सांकेत देगी। उस चौर हे के पहले र्कन रे पर 

ख्यिक करें  िह ां आप चैंफर बन न  च हते हैं। 

○ कम ांड ल इन र्फर आपको "दूसर  र्कन र  चुनें" सांकेत देगी। चौर हे के दूसरे र्कन रे पर 

ख्यिक करें। 
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उदाहरण: 

म न लीर्िए आपके प स एक बॉक्स क  3D मॉडल है और आप इसके कोनोां पर कोण ि ले र्कन रे बन न  

च हते हैं त र्क इसे अर्धक य ांर्त्रक रूप र्दय  ि  सके। 

1. चैंफर एज कमािंड तक पहिंचें: "CHAMFEREDGE" र इप करें  और Enter दब एां । 

2. चैंफर दूररर्ािं ट्नट्दाष्ट करें : सम न चैंफर कर बन ने के र्लए दोनोां दूररयोां के र्लए "2" दिा करें। 

3. ट्कनारो िं का चर्न करें : पहले कोने बन ने ि ले दो र्कन रोां पर ख्यिक करें। 

कम ांड चयर्नत कोने पर एक कोण ि ल  र्कन र  बन एग । आप बॉक्स के अन्य कोनोां पर चैंफर बन ने 

के र्लए इस प्रर्िय  को दोहर  सकते हैं। 

3D Draft Command in AutoCAD: 

The 3D Draft command in AutoCAD creates a drafted edge or a chamfer with unequal distances 

along two intersecting edges of a 3D object. 

Step-by-Step Procedure: 

1. Access the Command: 

○ Command Line: Type "DRAFTEDGE" and press Enter. 

○ Ribbon: Click on the "Solid" tab, then "Draft Edge" in the "Solid Editing" panel. 

2. Specify Draft Distances: 

○ The command line will prompt you to "Specify first draft distance." Enter the 

desired distance for the draft cut on the first edge. 

○ The command line will then prompt you to "Specify second draft distance." Enter 

the desired distance for the draft cut on the second edge. 
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3. Select Edges: 

○ The command line will prompt you to "Select first edge." Click on the first edge 

of the intersection where you want to create the draft. 

○ The command line will then prompt you to "Select second edge." Click on the 

second edge of the intersection. 

 

Example: 

Imagine you have a 3D model of a part with a sharp corner. You want to create a draft on the 

corner to facilitate easier manufacturing, where one side of the draft is longer than the other. 

1. Access the Draft Edge Command: Type "DRAFTEDGE" and press Enter. 

2. Specify Draft Distances: Enter "2" for the first distance and "1" for the second distance. 

3. Select Edges: Click on the two edges that form the corner. 

The command will create a drafted edge at the selected corner with the specified distances. 

AutoCAD में 3D डि ाफ्ट कमािंड: 

AutoCAD में 3D डि  फ्ट कम ांड र्कसी 3D ऑबे्जक्ट के दो प्रर्तचे्छदी र्कन रोां के स थ असम न दूररयोां के 

स थ एक डि  फे्टड एि य  बेिेल बन त  है। यह इन उदे्दश्योां के र्लए उपयोगी है: 

● ट्िट्नमााण को सुगम बनाना: आस न मशीर्नांग और असेंबली की सुर्िध  प्रद न करन । 

चरण-दर-चरण प्रट्िर्ा: 

1. कमािंड तक पहिंचें: 

○ कमािंड  ाइन: "DRAFTEDGE" र इप करें  और Enter दब एां । 

○ ररबन: "Solid" रैब पर ख्यिक करें , र्फर "Solid Editing" पैनल में "Draft Edge" पर 

ख्यिक करें। 



 

70 
 

2. डि ाफ्ट दूररर्ािं ट्नट्दाष्ट करें : 

○ कम ांड ल इन आपको "पहली डि  फ्ट दूरी र्नर्दाि करें" सांकेत देगी। पहले र्कन रे पर डि  फ्ट 

कर के र्लए ि ांर्ित दूरी दिा करें। 

○ कम ांड ल इन र्फर आपको "दूसरी डि  फ्ट दूरी र्नर्दाि करें" सांकेत देगी। दूसरे र्कन रे पर 

डि  फ्ट कर के र्लए ि ांर्ित दूरी दिा करें। 

3. ट्कनारो िं का चर्न करें : 

○ कम ांड ल इन आपको "पहल  र्कन र  चुनें" सांकेत देगी। उस चौर हे के पहले र्कन रे पर 

ख्यिक करें  िह ां आप डि  फ्ट बन न  च हते हैं। 

○ कम ांड ल इन र्फर आपको "दूसर  र्कन र  चुनें" सांकेत देगी। चौर हे के दूसरे र्कन रे पर 

ख्यिक करें। 

 

उदाहरण: 

म न लीर्िए आपके प स एक भ ग क  3D मॉडल है र्िसमें एक तेि कोन  है। आप आस न मशीर्नांग की 

सुर्िध  के र्लए कोने पर एक डि  फ्ट बन न  च हते हैं, िह ां डि  फ्ट क  एक र्कन र  दूसरे से लांब  हो। 

1. डि ाफ्ट एज कमािंड तक पहिंचें: "DRAFTEDGE" र इप करें  और Enter दब एां । 

2. डि ाफ्ट दूररर्ािं ट्नट्दाष्ट करें : पहली दूरी के र्लए "2" और दूसरी दूरी के र्लए "1" दिा करें। 

3. ट्कनारो िं का चर्न करें : कोने बन ने ि ले दो र्कन रोां पर ख्यिक करें। 

कम ांड र्नर्दाि दूररयोां के स थ चयर्नत कोने पर एक डि  फे्टड एि बन एग । 

3D Boolean Operations in AutoCAD: 

3D Boolean operations in AutoCAD allow you to combine, subtract, or intersect 3D solids to 

create complex shapes. This is a powerful tool for creating intricate designs and assemblies. 
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Types of Boolean Operations: 

● Union: Combines two or more solids into a single, unified solid. 

● Subtract: Removes a portion of one solid from another. 

● Intersect: Creates a new solid from the intersecting volume of two or more solids. 

Step-by-Step Procedure: 

1. Access the Boolean Operations: 

○ Command Line: Type "UNION", "SUBTRACT", or "INTERSECT" and press 

Enter. 

○ Ribbon: Click on the "Solid" tab, then select the desired Boolean operation in the 

"Solid Editing" panel. 

2. Select Objects: 

○ Select the first solid object. 

○ Select the second solid object. 

3. Perform the Operation: 

○ The command will perform the selected Boolean operation. 

 

Example: 

● Union: Imagine you have two separate 3D boxes. Using the "UNION" operation, you 

can combine them into a single, larger solid object. 

● Subtract: Imagine you have a 3D block and a 3D cylinder. Using the "SUBTRACT" 
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operation, you can remove the volume of the cylinder from the block, creating a hole in 

the block. 

● Intersect: Imagine you have two intersecting 3D cubes. Using the "INTERSECT" 

operation, you can create a new solid object representing only the overlapping volume 

of the two cubes. 

AutoCAD में 3D बूट् र्न ऑपरेिन: 

AutoCAD में 3D बूर्लयन ऑपरेशन आपको िर्रल आक र बन ने के र्लए 3D सॉर्लड्स को िोड़ने, 

घर ने य  प्रर्तचे्छद करने की अनुमर्त देते हैं। यह िर्रल र्डज़ इन और असेंबर्लय ाँ बन ने के र्लए एक 

शख्यक्तश ली उपकरण है। 

बूट् र्न ऑपरेिनो िं के प्रकार: 

● रू्ट्नर्न (Union): दो य  दो से अर्धक सॉर्लड्स को एकल, एकीकृत सॉर्लड में िोड़त  है। 

● सबरि ैक्ट (Subtract): एक सॉर्लड के एक र्हसे्स को दूसरे से हर  देत  है। 

● इिंररसेक्ट (Intersect): दो य  दो से अर्धक सॉर्लड्स के प्रर्तचे्छदी िॉलू्यम से एक नय  सॉर्लड 

बन त  है। 

चरण-दर-चरण प्रट्िर्ा: 

1. बूट् र्न ऑपरेिनो िं तक पहिंचें: 

○ कमािंड  ाइन: "UNION", "SUBTRACT", य  "INTERSECT" र इप करें  और Enter 

दब एां । 

○ ररबन: "Solid" रैब पर ख्यिक करें , र्फर "Solid Editing" पैनल में ि ांर्ित बूर्लयन 

ऑपरेशन क  चयन करें। 

2. ऑबे्जक््टस का चर्न करें : 

○ पहल  सॉर्लड ऑबे्जक्ट चुनें। 

○ दूसर  सॉर्लड ऑबे्जक्ट चुनें। 

3. ऑपरेिन करें : 

○ कम ांड चयर्नत बूर्लयन ऑपरेशन करेग । 
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उदाहरण: 

● रू्ट्नर्न: म न लीर्िए आपके प स दो अलग-अलग 3D बॉक्स हैं। "UNION" ऑपरेशन क  

उपयोग करके, आप उन्हें एक एकल, बडे़ सॉर्लड ऑबे्जक्ट में िोड़ सकते हैं। 

● सबरि ैक्ट: म न लीर्िए आपके प स एक 3D ब्लॉक और एक 3D र्सलेंडर है। "SUBTRACT" 

ऑपरेशन क  उपयोग करके, आप ब्लॉक से र्सलेंडर के िॉलू्यम को हर  सकते हैं, र्िससे ब्लॉक 

में एक िेद बन ि त  है। 

● इिंररसेक्ट: म न लीर्िए आपके प स दो प्रर्तचे्छदी 3D कू्ब्स हैं। "INTERSECT" ऑपरेशन क  

उपयोग करके, आप दो कू्ब्स के ओिरलैर्पांग िॉलू्यम क  प्रर्तर्नर्धत्व करने ि ल  एक नय  

सॉर्लड ऑबे्जक्ट बन  सकते हैं। 

 

 


